Spreadsheet Server .Net for use with PEOPLESOFT

Global Software, Inc’s Spreadsheet Server converts familiar spreadsheet software, such as Microsoft® Excel, into tightly integrated analytical tools for financial systems. Financial users can leverage the strength of spreadsheets with seamless dynamic integration to financial information. Spreadsheet Server eliminates the re-keying or downloading of data into spreadsheets and makes them an integral part of the financial application.
Spreadsheet Server for use with PEOPLESOFT

All rights reserved. No parts of this work may be reproduced in any form or by any means - graphic, electronic, or mechanical, including photocopying, recording, taping, or information storage and retrieval systems - without the written permission of the publisher.

Microsoft, Excel, Windows, Office, Outlook, Word, Access, and SQL Server are all registered trademarks of Microsoft Corporation. Oracle and PeopleSoft are registered trademarks of Oracle Corporation and/or its affiliates. IBM, DB2, iSeries, and AS/400 are trademarks or registered trademarks of International Business Machines Corporation. Trade names referenced are the service marks, trademarks, or registered trademarks of their respective manufacturers in the United States and/or other countries. Global Software, Inc. is not associated or affiliated in any manner with the respective owners of the foregoing trademarks, trade names or service marks unless expressly stated otherwise. The respective owners of the foregoing trademarks, trade names or service marks have not endorsed, certified or approved any of Global Software, Inc.’s products for use in connection with their respective products.

While every precaution has been taken in the preparation of this document, the publisher and the author assume no responsibility for errors or omissions, or for damages resulting from the use of information contained in this document or from the use of programs and source code that may accompany it. In no event shall the publisher and the author be liable for any loss of profit or any other commercial damage caused or alleged to have been caused directly or indirectly by this document.

Printed: February 2011
# Table of Contents

## Part I Spreadsheet Server Overview

1. Introducing Spreadsheet Server ................................................................. 3
2. Features & Benefits .................................................................................. 4

## Part II Spreadsheet Server Installation

1. Additional Components ........................................................................... 5
2. Spreadsheet Server Installation ............................................................... 7
3. Uninstall Process ..................................................................................... 8

## Part III Getting Started

1. Navigation .................................................................................................. 9
   - SServer Menu ....................................................................................... 10
   - SS Toolbar .......................................................................................... 12
   - SS Ribbon ........................................................................................... 13
2. Starting Spreadsheet Server ..................................................................... 15
3. Control Panel Overview ......................................................................... 17
   - Control Panel - Cache Options .......................................................... 19
   - Control Panel - Help Options ............................................................ 20
4. User Settings ............................................................................................ 21

## Part IV Building Spreadsheets

1. Build a Template .................................................................................... 29
   - Build a Template GXL Using Clear / Do Not Clear Worksheet .......... 33
   - Build a Template GXL Using Insert Column Data Only ................. 34
   - Build a Template GXL Using Shift Worksheet Data ....................... 35
2. Formula Assistant .................................................................................. 36
3. GXD Formula for Descriptions ............................................................... 41
4. GXL Formula for Account Values ......................................................... 42
5. Using Value Lists in a GXL Formula .................................................... 45
6. Locate Segment Value or Hierarchy ....................................................... 46
7. List Accounts for a GXL Formula ......................................................... 48
8. Expand/Collapse Row for a GXL Formula ........................................... 49
9. Spreadsheet Server Segment Lists ....................................................... 51
   - Create/Maintain Segment Lists ....................................................... 51
   - Using Segment Lists in a GXL Formula .......................................... 53
   - SSLDESC Formula ........................................................................... 54
   - View or Modify Segment List Values from within Excel ................. 55

## Part V Calculations

1. Calculation Options ............................................................................. 56

© 2011 ... Global Software, Inc.
Part VI  Drill Down Functionality  

1  General Grid Features  
   Copying/Exporting Records  

2  Drill Down to Detailed Account Balances  

3  Drill Down to Multiple Column Account Balances  

4  Drill Down to Journals per Account(s)  

Part VII  Review Account Master  

1  List Accounts  

2  Copy Accounts from Account List  

3  View Account Balances  

Part VIII  Miscellaneous Features  

1  SS Validation  

2  Account Security  

3  Generate Account Detail for Current Sheet  

4  Expand Detail Reports (GXE) - Account Detail  
   Expand a Single Source Line  
   Expand Multiple Source Lines  

5  Expand Detail Reports (GXE) - Journals Only  

6  Hide Rows with Zero Balances  

7  Disable / Enable Spreadsheet Server Formula Calculations  

8  Reset Host Server Connection  

9  View Log Entries  

Index
1 Spreadsheet Server Overview

1.1 Introducing Spreadsheet Server

What is Spreadsheet Server?
Global Software, Inc.’s Spreadsheet Server converts familiar spreadsheet software (Microsoft® Excel) into a tightly integrated analytical tool for financial systems. Financial users can leverage the strength of spreadsheets with seamless dynamic integration to financial information. Spreadsheet Server eliminates the re-keying or downloading of data into spreadsheets and makes those spreadsheets an integral part of financial applications.

Ease of Use
Based on knowledge of Excel, minimal training is required to use Spreadsheet Server. No programming or query knowledge is necessary. Users utilize the standard spreadsheet capabilities supplemented with simple cell formulas to gain access to dynamic financial information.

Leverage Spreadsheet Skills
While maintaining the full functionality of the spreadsheet application, Spreadsheet Server allows the user to mix General Ledger and non General Ledger data in a single worksheet. The combination of powerful spreadsheet functions (charting, text formatting, and sorting) and dynamic financial information provides the basis for building an income statement, balance sheet, and other financial statements.
1.2 Features & Benefits

Features
- Retrieve dynamic balances based on ledger specific formats and time periods (Period, Quarter, Year-to-Date, etc.)
- Retrieve balances using ranges, wildcards, segment lists or value lists
- Retrieve account descriptions
- Drill down to detailed account balances
- Drill down to journal detail for selected accounts
- Drill down to journal lines for a selected journal entry
- Copy drill down data and paste into spreadsheets or other documents

Benefits
- Leverage spreadsheet skills and write reports within minutes
- Eliminate requirement for IT or super-users to create/change financial reports
- No more downloading or re-keying of spreadsheet data
- Reduce number of days to close financial books; save just 3 hours per month per user and the investment is paid for in less than 12 months
- Publish executive-quality reports from current spreadsheet software
- Increase the efficiency and timeliness of the budgeting process
- Build a complete Executive Information System
- Create ad-hoc reports or perform account analysis within minutes
- Save financial user's time by combining reporting, account inquiry, and journal inquiry into one application; free up time for true business analysis
- Perform corporate consolidations with instant access to dynamic data
- Reduce external audit time by allowing easier, instant access to financial data with full drill down capabilities
- Reconcile accounts
- Print or email spreadsheets quickly and easily from a single, central application
2 Spreadsheet Server Installation

2.1 Additional Components

REQUIRED COMPONENTS

Application Configurator
A single installation of the Application Configurator for Spreadsheet Server must be completed by the administrator, and each user must be established and assigned a valid license key within the Application Configurator prior to using Spreadsheet Server. Contact the security administrator for the network location of the security and connections file.

Microsoft® .Net Framework
Microsoft .Net Framework 3.5 Service Pack 1 is a prerequisite for Spreadsheet Server. If it is not installed, then the Spreadsheet Server setup program will force the install.

Microsoft® Visual Studio Tools for Office
Microsoft Visual Studio 2010 Tools for Office Runtime is a prerequisite for Spreadsheet Server. If it is not installed, then the Spreadsheet Server setup program will force the install.

OPTIONAL COMPONENTS

Additional components may be required based upon the type of database being accessed. Contact your IT department to determine what is required to be installed.

iSeries™ DB2® Database
Either the ODBC component or the OLE DB Provider component of the IBM® iSeries Access™ for Windows® must be loaded onto the PC which will have Spreadsheet Server installed. By default, Spreadsheet Server expects to communicate to the iSeries host via ODBC. To communicate to the iSeries host via OLE DB, the Spreadsheet Server settings must be changed to indicate to connect to the host via the OLE DB Provider (see User Settings).

Run the setup program within IBM iSeries Access for Windows to determine that one of the Data Access components is installed.

Microsoft® SQL Server™ Database
The Microsoft SQL Server OLE DB Provider must be loaded on the PC which will have Spreadsheet Server installed.
Oracle® Database
Global provides a direct connect option for accessing the Oracle database. However, if you desire to connect to the Oracle database via the Oracle Client ODBC provider, then the Oracle Client software must be installed on each user’s computer. Within Oracle Client, configure the local service name, and assign the appropriate host name and port number.
2.2 Spreadsheet Server Installation

A separate Configurator program is used by your administrator or security officer to maintain license keys, valid Spreadsheet Server users, shared settings, and database connection user ID and password. The following installation steps assume that the Configurator program has been installed and that appropriate users, shared settings and connection data have been configured.

**NEW INSTALLS**

1. Check system compatibility: go to [www.queryexchange.com](http://www.queryexchange.com), select Run Licensing System Communication Verification and click Start. The system displays a message indicating the results of the test.

2. Close any open sessions of Excel.

3. Edit `SetupSharedSecurityFile.cmd` located in the Spreadsheet Server folder from the installation CD -or- from the downloaded and uncompressed zip file from Global's website and replace the path "P:\Spreadsheet Server" with the network path where you have saved your Configurator security file (DotNetSecurity.xml).


   **Note:** For Citrix users, edit and run `SetupCitrix.cmd` instead of `SetupSharedSecurityFile.cmd` to install Spreadsheet Server **WITHOUT** having the system automatically enable the Spreadsheet Server add-in for Excel.

   **Note:** If not previously installed, the setup program will force the install of required components prior to installing Spreadsheet Server (see [Additional Components](#)).

5. After the installation has completed successfully for the FIRST Spreadsheet Server user only, copy the following from `C:\Program Files\Global Software Inc\Spreadsheet Server` to the appropriate location:
   - Copy the AdHocQueries folder contents to the AdHoc's folder specified in the Configurator.
   - Copy the Application Data folder contents to the Segment Lists folder specified in the Configurator.

6. After the installation has completed successfully, it is recommended to:
   - Reboot if directed to do so.
   - Perform a Windows Update to check for .Net Framework Version 3.5 updates and load them if necessary.
   - Ensure that the appropriate component(s) are installed for connectivity (see [Additional Components](#)).
   - Go to the Settings-General tab and assign and/or verify the location of the network security and connections file (see [User Settings](#)).

7. Repeat steps 1, 2, 4 and 6 for each additional Spreadsheet Server user.

**UPGRADE INSTALLS**

As the steps required for an upgrade install may vary, it is important to read and follow the Upgrade Guidelines published when a new version is released.
2.3 Uninstall Process

Generally, it is not necessary to uninstall Spreadsheet Server prior to installing new versions. An uninstall should only be performed in order to completely remove the product from the PC.

1. Start Excel.

2. Signing on to Spreadsheet Server is optional. Cancellation of sign on is available.

3. For Excel 2003:
   - From the Excel menu, select Tools>Add-Ins. The Add-Ins panel appears.
   - De-select the add-in named Global's Spreadsheet Server .Net, and click OK.

   For Excel 2007:
   - Click the Office button. The Office Menu panel appears.
   - Click the Excel Options button. The Excel Options panel appears.
   - Select Add-Ins, and click Go. The Add-Ins panel appears.
   - De-select the add-in named Global's Spreadsheet Server .Net, and click OK.

   For Excel 2010:
   - From the Excel ribbon, select File>Options. The Excel Options panel appears.
   - Select Add-Ins, and click Go. The Add-Ins panel appears.
   - De-select the add-in named Global's Spreadsheet Server .Net, and click OK.

4. Ensure the SServer menu no longer appears.

5. Exit Excel.

6. From the desktop, click Start>Control Panel>Add or Remove Programs.

7. Select the Spreadsheet Server program and click the Change/Remove button.
3 Getting Started

3.1 Navigation

Spreadsheet Server uses the following navigation methods for processing functions on an Excel spreadsheet. Each function is not always available from each method.

- SServer Menu (see SServer Menu)
- Spreadsheet Server Toolbar (see SS Toolbar)
- Spreadsheet Server Ribbon (see SS Ribbon)

For Excel 2003:
- The SServer menu is accessible from the Excel menu bar.
- The Spreadsheet Server toolbar is accessible in the standard toolbar section.
- The Spreadsheet Server ribbon is NOT applicable.

For Excel 2007 and Above:
- The SServer menu and Spreadsheet Server toolbar are accessible from the Add-Ins ribbon.
- The Spreadsheet Server ribbon is only available when Spreadsheet Server is selected as an add-in to Excel.

NAVIGATION TIPS:
Throughout the manual navigation tips, noted by the convention "NAV TIP", will be listed indicating the various paths available to access a function.
3.1.1 **SServer Menu**

After Spreadsheet Server is initiated as an add-in to Excel, the SServer menu is added to Excel. The menu is used to access/process various functions within the application.

**For Excel 2003:**
The SServer menu is accessible from the Excel menu bar.

**For Excel 2007 and Above:**
The SServer menu is accessible from the Add-Ins ribbon.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drill Down</td>
<td>Opens the Drill Down panel, displaying account balances which make up the calculated amount (see <a href="#">Drill Down to Detailed Account Balances</a> and <a href="#">Drill Down to Multiple Column Account Balances</a>).</td>
</tr>
<tr>
<td>List Accounts</td>
<td>Opens the List Accounts panel, listing the accounts used in the GXL formula (<a href="#">List Accounts for a GXL Formula</a>) or allowing the user to generate a list of existing accounts (<a href="#">List Accounts</a>).</td>
</tr>
<tr>
<td>Locate Segment</td>
<td>Opens the Locate A Segment Value or Hierarchy panel, displaying a list of valid values or hierarchy values for each account segment (<a href="#">Locate Segment Value or Hierarchy</a>).</td>
</tr>
<tr>
<td>PC Cache</td>
<td>Opens the PC Cache panel, listing the cached records (<a href="#">Review/Refresh PC Cache</a>).</td>
</tr>
<tr>
<td>Settings</td>
<td>Opens the Settings panel, allowing the user to define various criteria to control processing (<a href="#">User Settings</a>).</td>
</tr>
<tr>
<td>Hide Rows with Zero Balances</td>
<td>Hides any spreadsheet row containing GXL formulas in which the net result is zero for all cells (<a href="#">Hide Rows with Zero Balances</a>).</td>
</tr>
<tr>
<td>Restore Hidden Rows</td>
<td>Displays previously hidden rows (<a href="#">Hide Rows with Zero Balances</a>).</td>
</tr>
<tr>
<td>Menu Item</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Generate Account Detail for Current Sheet</td>
<td>Opens the Generate Account Detail Options panel, allowing the user to create an audit trail listing the individual accounts and balances included in the GXL formulas on the worksheet (see Generate Account Detail for Current Sheet).</td>
</tr>
<tr>
<td>Generate All Detail Reports (GXE)</td>
<td>Generates detail reports for all GXE formulas in the workbook (see Expand Detail Reports (GXE) - Account Detail and Expand Detail Reports (GXE) - Journals Only).</td>
</tr>
<tr>
<td>Clear PC Cache and Recalculate</td>
<td>Clears and recalculates the cache file (see Review/Refresh PC Cache).</td>
</tr>
<tr>
<td>Formula Assistant</td>
<td>Opens the Formula Assistant panel, allowing the user to maintain parameters for a formula (see Formula Assistant).</td>
</tr>
<tr>
<td>Build a Template</td>
<td>Opens the Template Wizard panel, allowing the user to quickly create a template on a Spreadsheet Server spreadsheet (see Build a Template).</td>
</tr>
<tr>
<td>Fix Broken Links</td>
<td>Corrects all broken links to the .xla in the workbook.</td>
</tr>
<tr>
<td>Disable Spreadsheet Server</td>
<td>Closes the connection and disables Spreadsheet Server formulas (see Disable / Enable Spreadsheet Server Formula Calculations).</td>
</tr>
</tbody>
</table>
3.1.2 SS Toolbar

After Spreadsheet Server is initiated as an add-in to Excel, a Spreadsheet Server (SS) toolbar is added to Excel. The SS toolbar may be used as a convenient alternative to various SServer menu functions.

**For Excel 2003:**
The SS toolbar is accessible in the standard toolbar section.

**For Excel 2007 and Above:**
The SS toolbar is accessible from the Add-Ins ribbon.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Formula Assistant]</td>
<td>Opens the Formula Assistant panel, allowing the user to maintain parameters for a formula (see Formula Assistant).</td>
</tr>
<tr>
<td>![Data Validation]</td>
<td>Opens the Data Validation panel, allowing the user to create a validation list for a specific cell in Excel (see SS Validation).</td>
</tr>
<tr>
<td>![Clear Cache and Recalc]</td>
<td>Clears and recalculates the cache file (see Review/Refresh PC Cache).</td>
</tr>
<tr>
<td>![Drill Down]</td>
<td>Opens the Drill Down panel, displaying account balances which make up the calculated amount (see Drill Down to Detailed Account Balances and Drill Down to Multiple Column Account Balances).</td>
</tr>
<tr>
<td>![Hide Zero Rows]</td>
<td>Hides any spreadsheet row containing GXL formulas in which the net result is zero for all cells (see Hide Rows with Zero Balances).</td>
</tr>
<tr>
<td>![Unhide Zero Rows]</td>
<td>Displays previously hidden rows (see Hide Rows with Zero Balances).</td>
</tr>
<tr>
<td>![Segment Lists]</td>
<td>Opens the Maintain Segment Lists panel, allowing the user to create and/or maintain segment lists (see Create/Maintain Segment Lists).</td>
</tr>
<tr>
<td>![Settings]</td>
<td>Opens the Settings panel, allowing the user to define various criteria to control processing (see User Settings).</td>
</tr>
<tr>
<td>![Disable SS]</td>
<td>Closes the connection and disables Spreadsheet Server formulas (see Disable / Enable Spreadsheet Server Formula Calculations).</td>
</tr>
</tbody>
</table>
3.1.3 SS Ribbon

After Spreadsheet Server is installed and initiated as an add-in to Excel, a custom Spreadsheet Server (SS) ribbon is added to Excel for Excel 2007 (and above) users. The SS ribbon may be used as a convenient alternative to various SServer menu functions.

For Excel 2003:
The SS ribbon is *NOT* applicable.

For Excel 2007 and Above:
The SS ribbon only appears when Spreadsheet Server is selected as an add-in to Excel.

*Note: If the ribbon does not appear, go to Settings and click the Add Excel Ribbon button (see User Settings).*

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Log</td>
<td>Opens the Log Viewer panel, where the user may view information and error log entries, copy selected log entries, email or clear the log file (see View Log Entries).</td>
</tr>
<tr>
<td>Recalc</td>
<td>Recalculates all formulas in the workbook. Click on the arrow to access additional functions (i.e. recalculate formulas for workbook, worksheet or selection, fix broken links, etc.).</td>
</tr>
<tr>
<td>PC Cache</td>
<td>Opens the PC Cache panel, listing the cached records (see Review/Refresh PC Cache). Click on the arrow to access additional functions.</td>
</tr>
<tr>
<td>Generate Reports</td>
<td>Generates detail reports for all GXE formulas in the workbook (see Expand Detail Reports (GXES) - Account Detail and Expand Detail Reports (GXES) - Journals Only). Click on the arrow to access additional functions (i.e. all or selected GXEs, etc.).</td>
</tr>
<tr>
<td>Drill Down</td>
<td>Opens the Drill Down panel, displaying account balances which make up the calculated amount (see Drill Down to Detailed Account Balances and Drill Down to Multiple Column Account Balances).</td>
</tr>
<tr>
<td>Insert Table</td>
<td>Opens the Create Table panel, allowing the user to create a table for a selected range of data.</td>
</tr>
<tr>
<td>Summarize with Pivot Table</td>
<td>Opens the Pivot Table ribbon, allowing the user to create a pivot table using the data in the selected table.</td>
</tr>
<tr>
<td>Hide Zero Balance Rows</td>
<td>Hides any spreadsheet row containing GXL formulas in which the net result is zero for all cells (see Hide Rows with Zero Balances).</td>
</tr>
<tr>
<td>Restore Hidden Rows</td>
<td>Displays previously hidden rows (see Hide Rows with Zero Balances).</td>
</tr>
<tr>
<td>Expand Row</td>
<td>Expands the balances for the selected GXL formulas on a row into account details (see Expand/Collapse Row for a GXL Formula). Click on the arrow to access additional functions (i.e. expand row or expand all rows).</td>
</tr>
<tr>
<td>Collapse Row</td>
<td>Removes the expanded account detail rows in the selected section (see Expand/Collapse Row for a GXL Formula). Click on the arrow to access additional functions (i.e. collapse row or collapse all rows).</td>
</tr>
<tr>
<td>Menu Item</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Formula Assistant</td>
<td>Opens the Formula Assistant panel, allowing the user to maintain parameters for a formula (see <a href="#">Formula Assistant</a>).</td>
</tr>
<tr>
<td>Build a Template</td>
<td>Opens the Template Wizard panel, allowing the user to quickly create a template on a Spreadsheet Server spreadsheet (see <a href="#">Build a Template</a>).</td>
</tr>
<tr>
<td>Segment Lists</td>
<td>Opens the Maintain Segment Lists panel, allowing the user to create and/or maintain segment lists (see <a href="#">Create/Maintain Segment Lists</a>).</td>
</tr>
<tr>
<td>Data Validation</td>
<td>Opens the Data Validation panel, allowing the user to create a validation list for a specific cell in Excel (see <a href="#">SS Validation</a>).</td>
</tr>
<tr>
<td>Locate Segment</td>
<td>Opens the Locate A Segment Value or Hierarchy panel, displaying a list of valid values or hierarchy values for each account segment (see <a href="#">Locate Segment Value or Hierarchy</a>).</td>
</tr>
<tr>
<td>Enable</td>
<td>Opens the Sign On panel, allowing the user to start Spreadsheet Server (see <a href="#">Starting Spreadsheet Server</a>).</td>
</tr>
<tr>
<td>Disable</td>
<td>Closes the connection and disables Spreadsheet Server formulas (see <a href="#">Disable / Enable Spreadsheet Server Formula Calculations</a>).</td>
</tr>
<tr>
<td>Settings</td>
<td>Opens the Settings panel, allowing the user to define various criteria to control processing (see <a href="#">User Settings</a>).</td>
</tr>
</tbody>
</table>
3.2 Starting Spreadsheet Server

Follow the steps below to start the add-in component of Spreadsheet Server.
- When user settings are set to start Spreadsheet Server during Excel startup, then step 2 is not applicable.
- When unattended (auto) signon is activated, steps 3 and 4 are not applicable.

1. Start Excel.

2. In Excel from the SServer Disabled menu, select Start Spreadsheet Server -or- select the SS ribbon equivalent (see SS Ribbon). The Sign On to Spreadsheet Server dialog box appears.

3. Various methods are available for signing onto Spreadsheet Server based upon the ledger type being accessed:

   **Option 1 - SQL Server or DSN Database:**
   - Host Name or IP Address - host or IP Address that hosts the database
   - Database Lib Name - name of the PeopleSoft database library
   - User ID - value defaults based on entry for Windows User in the Configurator
   - Password - only required if a password was created for the user in the Configurator

   **Option 2 - Oracle Database - Direct Connect:**
   - Select the Direct check box
   - Specify the following fields:
     - Host - host or IP Address that hosts the Oracle database
     - Service - Oracle Service Name indicating where the database is located
     - Port - port number
     - User ID - value defaults based on entry for Windows User in the Configurator
     - Password - only required if a password was created for the user in the Configurator
Option 3 - Oracle Database - Connect via Oracle Client:
- Do not select the Direct check box
- Specify the following fields:
  - Oracle Service Name - Service Name configured via the Oracle Net Manager
  - User ID - value defaults based on entry for Windows User in the Configurator
  - Password - only required if a password was created for the user in the Configurator

4. Click OK.
3.3 Control Panel Overview

The Spreadsheet Server Control Panel is a central panel from which multiple functions can be accessed. Some of these functions may also be accessed from the SServer menu within Excel. Below is a list and general description of the functions which can be initiated from the Control Panel.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Refer to for more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Panel</td>
<td>View balances for a selected account or accounts, and subsequently drill down to the journals supporting the balances.</td>
<td>View Account Balances</td>
</tr>
<tr>
<td>File</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td>Close the Control Panel.</td>
<td></td>
</tr>
<tr>
<td>Cache</td>
<td></td>
<td></td>
</tr>
<tr>
<td>View PC Cache</td>
<td>View balances currently stored in the PC Cache file.</td>
<td>Review/Refresh PC Cache</td>
</tr>
<tr>
<td>Clear PC Cache</td>
<td>Clear balances currently stored in the PC Cache file.</td>
<td></td>
</tr>
<tr>
<td>Accounts Profile</td>
<td>Identify accounts to which the user has authority to access.</td>
<td>Account Security</td>
</tr>
<tr>
<td>Segment Lists</td>
<td>Add, modify, delete, and lock segment lists.</td>
<td>Create/Maintain Segment Lists</td>
</tr>
<tr>
<td>List Accounts</td>
<td>Generate a list of existing accounts. Filtering is available to control which accounts are listed.</td>
<td>List Accounts</td>
</tr>
<tr>
<td>Settings</td>
<td>Define various criteria to control processing for the user. Criteria includes but is not limited to: general options, ledger specific criteria, processing quarters, warning controls, database locations, ad hoc queries, and performance statistics.</td>
<td>User Settings</td>
</tr>
<tr>
<td>Help</td>
<td></td>
<td></td>
</tr>
<tr>
<td>User Manual</td>
<td>Connect to Global's On-Line Help web page, where have access to HTML and PDF versions of the Spreadsheet Server User Manual.</td>
<td></td>
</tr>
<tr>
<td>Register Sample DSN</td>
<td>Not applicable for PeopleSoft databases.</td>
<td></td>
</tr>
<tr>
<td>About</td>
<td>Display company and product information. From this panel, also have access to Global's website for online manuals, product updates and other information.</td>
<td></td>
</tr>
</tbody>
</table>

To Access the Control Panel:
1. From the desktop, click Start>Programs>Global Software Spreadsheet Server>Spreadsheet Server Control Panel. The Sign On to Spreadsheet Server dialog box appears.

2. On the Sign On dialog box, specify the appropriate data (see Starting Spreadsheet Server) and click OK. The Spreadsheet Server Control Panel appears.
3. Multiple functions are available from the Control Panel. Use the table above to see a list of available functions, a brief description of each function, and a link to where the function is further explained in the User Manual.
3.3.1 Control Panel - Cache Options

When spreadsheets are calculated or calculations are performed on the Control Panel, Spreadsheet Server stores the account balances in the PC’s cache database. Spreadsheet Server enables the user to view the balances stored in the PC Cache file and to quickly clear the file.

The Control Panel uses the same caching process as used in the Excel portion of Spreadsheet Server. After an account or account combination is queried, the balances are stored in the cached memory. Any subsequent calculations will use the records stored in memory. To ensure the latest balances are retrieved, use the clear cache process prior to re-running the GXL on the Control Panel.

1. On the Spreadsheet Server Control Panel, click the Cache tab. The system displays two options.

2. Choose from the following options:
   - View PC Cache - Displays the PC Cache panel listing the cached records.
   - Clear PC Cache - Clears the PC Cache file and returns to the Spreadsheet Server Control Panel.

   **Nav Tip:** Both of these options are also available in Excel via the SServer menu and SS ribbon (see SServer Menu or SS Ribbon).

   **Note:** Refer to Review/Refresh PC Cache for more information.
3.3.2 Control Panel - Help Options

Spreadsheet Server provides multiple features to assist the user in using the application, such as easy access to user manuals and to Global's website to check for product upgrades.

1. On the Spreadsheet Server Control Panel, click the Help tab. The system displays multiple options.

2. Choose from the following options:
   - Register Sample DSN - Not applicable for PeopleSoft databases.
   - About - Displays a panel listing Global's address and contact information. A button is available on this panel to access Global's website for online manuals, product upgrades and other information.
3.4 User Settings

User Settings allow the user to define various criteria to control processing. The majority of the options define processing for all users on the PC; however, various options (auto-start, display tooltips and enhanced logging) are defined for each individual user. Settings for General Ledger Type, and Segment List, AdHocs and Designer GL Definition locations may be set and/or overridden based upon parameters defined on the Shared Settings tab in the Configurator component.

1. In Excel from the SServer menu, select Settings. The General Settings panel appears.

   **Nav Tip:** This panel may also be accessed by selecting the Settings tab on the Control Panel -or- by selecting the SS toolbar or ribbon equivalent (see SS Toolbar or SS Ribbon).

2. Use the table to enter data on the General Settings panel, or to access other functions.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Miscellaneous:</td>
<td></td>
</tr>
<tr>
<td>General Ledger Type</td>
<td>Identify the General Ledger package being used. Use the drop down list to select the appropriate General Ledger type/name.</td>
</tr>
<tr>
<td>Label Language</td>
<td>Identify the language to use when displaying menu labels. Use the drop down list to select the appropriate language.</td>
</tr>
<tr>
<td>Retrieve from Preloaded Local PC Database</td>
<td>Not applicable for PeopleSoft databases.</td>
</tr>
<tr>
<td>Operating Completely Disconnected from Host</td>
<td>Not applicable for PeopleSoft databases.</td>
</tr>
<tr>
<td>Connection Options:</td>
<td>Identify the provider to be used when connecting to the host General Ledger system.</td>
</tr>
<tr>
<td>iSeries/DSN/SQL Server/Oracle/8i(ODBC)/OLE</td>
<td>Identifies the connection protocol.</td>
</tr>
<tr>
<td>DB</td>
<td></td>
</tr>
<tr>
<td>SQL Server Owner Override</td>
<td>Identifies the database owner override.</td>
</tr>
<tr>
<td>Network Security and Connections File</td>
<td>Browse and select the location of the Security and Connections File as specified in the Configurator. This function is password protected.</td>
</tr>
<tr>
<td>Standard Options:</td>
<td></td>
</tr>
<tr>
<td>Start Automatically when Excel Starts</td>
<td>Indicates to sign on to Spreadsheet Server automatically each time Excel is started. Otherwise, Spreadsheet Server must be manually started each time Excel is started.</td>
</tr>
<tr>
<td>Drill Down: Include Zero Balance Accounts</td>
<td>Indicates to include accounts with activity but zero balances in the account balances drill down window.</td>
</tr>
<tr>
<td>List Accounts: Exclude Inactive</td>
<td>Not applicable for PeopleSoft databases.</td>
</tr>
<tr>
<td>GXL: Insert Trailing Dash</td>
<td>Indicates to append a dash at the end of the account string.</td>
</tr>
<tr>
<td>Override List Separator With</td>
<td>Indicates to use a value other than a comma (,) to separate items in a value list, and indicates the character to use.</td>
</tr>
<tr>
<td>SQL Timeout</td>
<td>Indicates the maximum time allowed for a query to run on the host system.</td>
</tr>
<tr>
<td>Template: Default Currency</td>
<td>Indicates the currency value to default when using the Template Wizard.</td>
</tr>
<tr>
<td>GXE: Last Column</td>
<td>Identifies the last column GXE formulas will process.</td>
</tr>
<tr>
<td>Display Tooltips</td>
<td>Indicates to display tooltips on various Spreadsheet Server panels. Currently tooltips are available on the Settings, Build a Template and Formula Assistant panels.</td>
</tr>
<tr>
<td>Enhanced Logging</td>
<td>Indicates to record additional error message logging. Once an error has been resolved, clear the log file and to de-select the option for optimal processing. Refer to View Log Entries for more information. Nav Tip: Use the View Log button to display, email or clear the log file. When the Enhanced Logging option is selected, an additional button, View Log, appears on the Spreadsheet Server ribbon in Excel.</td>
</tr>
<tr>
<td>Segment Delimiter</td>
<td>Specify the delimiter for separating account segments.</td>
</tr>
<tr>
<td>Range Delimiter</td>
<td>Specify the delimiter for separating from/to values in a range. This defaults to a period and should only be changed if periods exist within the account segment values.</td>
</tr>
<tr>
<td>Expand Row</td>
<td>Specify whether the Expand Row function expands detail rows up or down.</td>
</tr>
<tr>
<td>Button</td>
<td>Function</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>View Log</td>
<td>Displays the Log Viewer panel, where the user may see information and error log entries, copy selected log entries, email or clear the log file. Refer to View Log Entries for more information.</td>
</tr>
<tr>
<td>Maintain Accounts Profile</td>
<td>Displays the Accounts profile panel. Refer to Account Security for more information.</td>
</tr>
<tr>
<td>Maintain Segment Lists</td>
<td>Displays the Maintain Segment Lists panel. Refer to Create/Maintain Segment Lists for more information.</td>
</tr>
<tr>
<td>Re-Enable Spreadsheet Server</td>
<td>Restarts Spreadsheet Server connection in the event the connection was lost or if calculations have been disabled.</td>
</tr>
<tr>
<td>About</td>
<td>Displays a panel listing Global's address and contact information. A button is available on this panel to access Global's website for online manuals, product upgrades and other information.</td>
</tr>
<tr>
<td>Add Excel Ribbon</td>
<td>Registers and adds the custom Spreadsheet Server ribbon in Excel. The button is only available when the ribbon is not currently registered for an Excel 2007 (or above) user.</td>
</tr>
</tbody>
</table>
3. Use the table to enter data on the Ledger Specifics - PeopleSoft panel.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set ID</td>
<td>Identifies the PeopleSoft set ID.</td>
</tr>
<tr>
<td>Apply Effective Date Criteria on Accounts</td>
<td>Select the check box to indicate to include the effective date as part of the search criteria in drill downs.</td>
</tr>
<tr>
<td>Ignore Ledger on Multicolumn Drill Down</td>
<td>Select the check box to indicate to ignore the ledger account segment parameter on a multi-column drill down.</td>
</tr>
<tr>
<td>Available Business Units for User</td>
<td>Displays the business units available for the current user.</td>
</tr>
</tbody>
</table>
4. Use the table to enter data on the Quarters panel.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quarter Periods</td>
<td>Indicates the starting and ending period numbers for each of the four quarters.</td>
</tr>
</tbody>
</table>
5. Use the table to enter data on the Database Locations panel.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changed Shared Documents Location</td>
<td>For Administrators in Citrix environments only, use the Browse button to select the location to which to move the basic folders. This function is password protected. Contact Global for more information.</td>
</tr>
<tr>
<td>Segment Lists Location</td>
<td>Defines the location of the Spreadsheet Server Segment Lists database. This may be a local or network drive.</td>
</tr>
<tr>
<td>PC Cache Location</td>
<td>Defines the location of the PC Cache database.</td>
</tr>
<tr>
<td>AdHoc's Location</td>
<td>Defines the location of the AdHoc SQL Statements. This folder should be reserved for AdHoc queries only.</td>
</tr>
<tr>
<td>PC Local Database</td>
<td>Not applicable for PeopleSoft databases.</td>
</tr>
<tr>
<td>Spreadsheet Server Budget Balances</td>
<td>Not applicable for PeopleSoft databases.</td>
</tr>
<tr>
<td>Designer GL Definition Location</td>
<td>Not applicable for PeopleSoft databases.</td>
</tr>
<tr>
<td>Drill Down Layouts</td>
<td>Defines the location of the user-defined drill down grid layouts.</td>
</tr>
</tbody>
</table>
6. The Performance panel displays various performance counts and statistics with respect to how the product is processing. Click the Reset Statistics button to clear the performance statistic values, thus allowing counts and statistics to start accumulating again.

7. Use the table to enter data on the Performance panel.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQL Execution Threshold</td>
<td>Indicates the time limit (in seconds) for which to create an entry in the error log when a SQL statement exceeds the threshold specified.</td>
</tr>
</tbody>
</table>

8. Click About to display a panel listing Global’s contact information and a button to access online manuals.

9. Click Add Excel Ribbon to register and add the custom Spreadsheet Server ribbon in Excel. The button is only available when the ribbon is not currently registered for an Excel 2007 (or above) user.

10. Click OK to write changes and exit.
4 Building Spreadsheets

Spreadsheet Server retrieves financial data from the General Ledger into Excel using the following formulas:

- **GXD** - Returns an account description (Refer to [GXD Formula for Descriptions](#)).
- **GXL** - Returns an account balance (Refer to [GXL Formula for Account Values](#)).
- **GXE** - Explodes summary data line into detail data lines (Refer to [Expand Detail Reports (GXE) - Account Detail](#) and [Expand Detail Reports (GXE) - Journals Only](#)).
- **GXC** - Customized formula. Contact Global for configuration of new formulas.
- **SSLDESC** - Returns a segment list description (Refer to [SSLDESC Formula](#)).

These formulas can be used in a spreadsheet cell in the same manner as other spreadsheet functions.

Spreadsheet Server provides tools for starting a spreadsheet (see [Build a Template](#)) and for entering formulas (see [Formula Assistant](#)).
4.1 Build a Template

Build a Template is a tool used to aid in quickly creating a template within a Spreadsheet Server spreadsheet. This tool populates the necessary rows and columns with required parameters and account segment values as provided by the user. The tool inserts a GXL or GXE formula using the parameters and account segment values.

1. In Excel from the SServer menu, select Build a Template. The Spreadsheet Server Template Wizard panel appears.

**Nav Tip:** This panel may also be accessed by using the shortcut key Shift+Ctrl+B from within Excel -or- by selecting the SS ribbon equivalent (see SS Ribbon).

2. Select the tab of the desired formula. The selected formula panel appears.

**Note:** To modify the panel size, click on the edge of the panel and drag to the desired size.
3. Use the table to enter data on the GXL - Spreadsheet Server Template Wizard panel.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GXL</td>
<td>Returns a single balance from the ledger. Refer to <a href="#">GXL Formula for Account Values</a> for more information.</td>
</tr>
<tr>
<td>Worksheet</td>
<td>Identify the worksheet name which will receive the template.</td>
</tr>
<tr>
<td>Starting Column</td>
<td>Identify the starting column for the template.</td>
</tr>
<tr>
<td>Starting Row</td>
<td>Identify the starting row for the template.</td>
</tr>
<tr>
<td>Balance Type</td>
<td>Identify the balance type. Valid values are A (Actual), B (Budget), and E (Encumbrance).</td>
</tr>
<tr>
<td>Business Unit</td>
<td>Identify the reporting business unit.</td>
</tr>
<tr>
<td>Year</td>
<td>Identify the reporting year.</td>
</tr>
<tr>
<td>Format</td>
<td>Identify the time range for which to retrieve data. Valid formats are PER, QTR, YTD, LTD, RANGE and BP.</td>
</tr>
<tr>
<td>Period</td>
<td>Specify the corresponding period, quarter number, or range of periods (i.e. 1.5 for periods 1 thru 5) for the specified format.</td>
</tr>
<tr>
<td>Currency</td>
<td>Indicate a valid currency code.</td>
</tr>
<tr>
<td>Available Designer GL</td>
<td>If applicable, use the drop down box to select a Designer GL Definition from which to retrieve data. After selecting a value, the system changes the parameters on the panel to match the selected definition.</td>
</tr>
<tr>
<td>Definitions</td>
<td></td>
</tr>
<tr>
<td>Line Description</td>
<td>Enter a description for the account or group of accounts specified.</td>
</tr>
<tr>
<td>Clear Worksheet</td>
<td>Select the radio button to clear all cell data on the target worksheet when inserting data. For an example refer to <a href="#">Build a Template GXL Using Clear / Do Not Clear Worksheet</a>.</td>
</tr>
<tr>
<td>Do Not Clear Worksheet</td>
<td>Select the radio button to not clear cell data on the target worksheet when inserting data. For an example refer to <a href="#">Build a Template GXL Using Clear / Do Not Clear Worksheet</a>.</td>
</tr>
<tr>
<td>Shift Worksheet Data</td>
<td>Select the radio button to insert the GXL formula in the target cell and to insert the ledger and segment specific data to newly inserted columns and rows to the top and to the left of the existing worksheet data. For an example refer to <a href="#">Build a Template GXL Using Shift Worksheet Data</a>. Note: The Shift option does not function for Excel 2000 and prior.</td>
</tr>
<tr>
<td>Insert Column Data Only</td>
<td>This check box becomes active after data has been inserted using the Insert icon on the toolbar. Select the check box to insert an additional column of parameters. For an example refer to <a href="#">Build a Template GXL Using Insert Column Data Only</a>.</td>
</tr>
<tr>
<td>Skip a Row</td>
<td>Select the check box to insert an additional row between the last column parameter and the account segment title row.</td>
</tr>
<tr>
<td>Invert Sign</td>
<td>Select the check box to reverse the sign on the account balance display.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Account Segments:</td>
<td>If necessary, use the scroll bar to access additional account segments.</td>
</tr>
<tr>
<td>Display/Use</td>
<td>Select the check box to include the account segment. <strong>Note:</strong> Segments may only be excluded from the bottom up.</td>
</tr>
<tr>
<td>Row/Col</td>
<td>Select the button to toggle between Row and Col. This button determines if the account segment will be located in the template parameters column or by default, on the template account segment row.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter the description to be used as the account segment title.</td>
</tr>
<tr>
<td>Value</td>
<td>Enter the value to default on the template for the account segment. The value may be a single value, a wildcard, or the first value in a range.</td>
</tr>
<tr>
<td>Range thru Value</td>
<td>If applicable, select the check box and indicate the ending range value for the account segment.</td>
</tr>
</tbody>
</table>

![Spreadsheet Server Template Wizard](image)
4. Use the table to enter data on the GXE - Spreadsheet Server Template Wizard panel.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GXE:</td>
<td>Fills detail balances into the specified worksheet. Refer to Expand Detail Reports (GXE) - Account Detail for more information.</td>
</tr>
<tr>
<td>Source Worksheet</td>
<td>Identify the name of the worksheet that contains the summary formulas that will be expanded and onto which to insert the GXE formula.</td>
</tr>
<tr>
<td>Target Worksheet</td>
<td>Identify the name of the new or existing worksheet that contains the final formatted worksheet and will receive the expanded detail.</td>
</tr>
<tr>
<td>Source Detail Row</td>
<td>Identify the row number in the source worksheet that contains the summary formulas.</td>
</tr>
<tr>
<td>Target Table, Range, or Row</td>
<td>Identify the target table, range name, or first row on the target worksheet to begin inserting the expanded detail.</td>
</tr>
<tr>
<td>Headings</td>
<td>Indicate whether or not to include column headings when expanding details. If not specified, N (No) is assumed.</td>
</tr>
<tr>
<td>Autofit</td>
<td>Indicate whether or not to autofit columns when expanding details. If not specified, N (No) is assumed.</td>
</tr>
<tr>
<td>Clear Sheet</td>
<td>Indicate whether or not to clear the target worksheet before expanding details. If not specified, N (No) is assumed. Note: This value MUST be N when a TABLE or RANGE is specified for the Target Table/Range/Row parameter.</td>
</tr>
<tr>
<td>Journals Only Column</td>
<td>Identify the column for which to generate journal detail. Refer to Expand Detail Reports (GXE) - Journals Only for more information.</td>
</tr>
<tr>
<td>Starting Column</td>
<td>Identify the starting column for the template.</td>
</tr>
<tr>
<td>Starting Row</td>
<td>Identify the starting row for the template.</td>
</tr>
</tbody>
</table>

5. After the appropriate data has been entered and verified, click one of the following toolbar icons or buttons.
   - Insert (icon) -- inserts parameter labels and values and the formula to the selected worksheet, increments Period and Starting Column/Row values for the next GXL/GXE formula, and keeps the panel open for additional inserts.
   - Copy (icon) -- copies the formula to the Windows clipboard.
   - Insert (button) -- inserts parameter labels and values and the formula to the selected worksheet and closes the panel.
   - Cancel/Close (button) -- closes the panel.
4.1.1 Build a Template GXL Using Clear / Do Not Clear Worksheet

The following example demonstrates using the Clear Worksheet and/or the Do Not Clear Worksheet options when processing a GXL formula from the Build a Template function.

1. From an open worksheet in Excel, from the SServer menu, select Build a Template -or- select the SS ribbon equivalent. The Spreadsheet Server Template Wizard panel appears.

2. Key the appropriate ledger parameters and account segment data.

3. Click the Insert button at the bottom of the panel. The panel closes and the template is generated.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Balance Type</td>
<td>A</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Business Unit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Year</td>
<td>2003</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Format</td>
<td>FER</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Period</td>
<td>8</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Currency</td>
<td>USD</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Ledger</td>
<td>LOCAL</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Fund Code</td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Department</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Class Field</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Program Code</td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>ChartField</td>
<td>*</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Account</td>
<td>100000</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>*</td>
<td>Project Affiliate</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Statistics Code</td>
<td>*</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Template Account Line</td>
<td>(2,227,545)</td>
<td></td>
</tr>
</tbody>
</table>
4.1.2 Build a Template GXL Using Insert Column Data Only

The following example demonstrates using the Insert Column Data Only option when processing a GXL formula from the Build a Template function. This option is used to insert multiple columns onto a single worksheet.

1. From an open worksheet in Excel, from the SServer menu, select Build a Template -or- select the SS ribbon equivalent. The Spreadsheet Server Template Wizard panel appears.

2. Key the appropriate ledger parameters and account segment data.

3. Click the Insert icon on the toolbar. The template is generated, but the panel remains open and the Period, Starting Column and Starting Row values are incremented, and the Insert Column Data Only check box is selected.

4. Key any necessary changes to the ledger parameters.

5. Click the Insert icon on the toolbar. The column data and GXL formula are added to the template, and the Period, Starting Column and Starting Row values are incremented.

6. Repeat steps 4 and 5 until all desired columns are added.

7. Click the Close button to close the panel.

<p>| | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Business Unit</td>
<td>US006</td>
<td>US005</td>
<td>US005</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Year</td>
<td>2003</td>
<td>2003</td>
<td>2003</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Format</td>
<td>PER</td>
<td>PER</td>
<td>PER</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Period</td>
<td>8</td>
<td>?</td>
<td>8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Currency</td>
<td>USD</td>
<td>USD</td>
<td>USD</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Ledger</td>
<td>Local</td>
<td>Local</td>
<td>Local</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| 10 | Fund Code | * | * | *
| 12 | Department | Class Field | Program Code | ChartField1 | Account | Project | Affiliate | Statistics Code |
| 18 | 214000 | * | * | * | * | * | Template Account Line | (448,294), (526,889), (181,563) |
4.1.3 Build a Template GXL Using Shift Worksheet Data

The following example demonstrates using the Shift Worksheet Data option when processing a GXL formula from the Build a Template function. This option is used to insert the required rows and columns used for a GXL formula into an existing non-Spreadsheet Server worksheet.

Note: The Shift option does not function for Excel 2000 and prior.

1. Start with an existing non-Spreadsheet Server worksheet in Excel. Select the first cell to be populated with a formula (i.e. B4 in the spreadsheet below), then from the SServer menu, select Build a Template -or- select the SS ribbon equivalent. The Spreadsheet Server Template Wizard panel appears.

2. Select the option Shift Worksheet Data. The Starting Column and Starting Row fields are modified to display the cell previously selected on the worksheet.

3. Enter the appropriate values on the Spreadsheet Server Template Wizard panel.

4. Click the Insert icon -or- button. The panel closes and the column and row parameters, and formula are added to the existing worksheet.
### 4.2 Formula Assistant

The Formula Assistant is a tool used to aid in quickly creating formulas within a Spreadsheet Server spreadsheet. Currently the Formula Assistant is applicable for GXC, GXD, GXE, and GXL formulas.

1. In Excel from the SServer menu, select Formula Assistant. The Formula Assistant panel appears open to the GXL tab -or- if Formula Assistant was launched while on a SS formula, the panel opens the corresponding formula tab.

   **Nav Tip:** *This panel may also be accessed by using the shortcut key Shift+Ctrl+F from within Excel -or- by selecting the SS toolbar or ribbon equivalent (see SS Toolbar or SS Ribbon).*

2. Select the tab of the desired formula. The selected formula panel appears.

   **Note:** *For efficient processing use cell references to identify individual formula parameters. However, if literal values are keyed in the entry boxes, they must be placed in double quotes (").*

   **Hint:** Shortcut for selecting cell references:
   - On the Formula Assistant panel, select the desired field.
   - Press the Control Key. The Formula Assistant panel becomes transparent and is shifted up.
   - On the worksheet, select the desired cell.
   - Press the Control Key or click the Expand button. This system returns the selected cell to the field.

   **Hint:** If necessary, use F4 to lock either the row and/or column value of the cell reference.
3. Use the table to enter formula specific data on the GXL - Formula Assistant panel.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GXL:</td>
<td>Returns a single balance from the ledger. Refer to GXL Formula for Account Values for more information. Note: This section assumes that the parameters will be laid out top down in a single column. Therefore, when entering a cell reference in the Balance Type field and moving to the next field, the system will populate the other fields sequentially thru the Period field.</td>
</tr>
<tr>
<td>Balance Type</td>
<td>Identify the balance type. Valid values are A (Actual), B (Budget), or E (Encumbrance).</td>
</tr>
<tr>
<td>Business Unit</td>
<td>Identify the reporting business unit.</td>
</tr>
<tr>
<td>Year</td>
<td>Identify the reporting year.</td>
</tr>
<tr>
<td>Format</td>
<td>Identify the time range for which to retrieve data. Valid formats are PER, QTR, YTD, LTD, and RANGE.</td>
</tr>
<tr>
<td>Period</td>
<td>Identify the corresponding period, quarter number, or range of periods for the specified format.</td>
</tr>
<tr>
<td>Currency</td>
<td>Select the check box and identify the currency code.</td>
</tr>
<tr>
<td>Invert Sign</td>
<td>Select the check box to reverse the sign on the account balance display.</td>
</tr>
<tr>
<td>Account Segments:</td>
<td>Identify the required account segments to be used by the formula. This area assumes that the segments will be laid out next to each other on one row, so entering a value and clicking on the down arrow will populate the rest of the fields. For example, if the cell reference entered for the first account segment is A13, then clicking on the down arrow for the first account segment will populate the following fields with B13, C13, etc.</td>
</tr>
</tbody>
</table>
4. Use the table to enter formula specific data on the GXE - Formula Assistant panel.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GXE:</td>
<td>Fills detail balances into the specified worksheet. Refer to Expand Detail Reports (GXE) - Account Detail for more information.</td>
</tr>
<tr>
<td>Source Worksheet</td>
<td>Identify the name of the worksheet that contains the summary formulas that will be expanded.</td>
</tr>
<tr>
<td>Target Worksheet</td>
<td>Identify the name of the new or existing worksheet that contains the final formatted worksheet and will receive the expanded detail.</td>
</tr>
<tr>
<td>Source Detail Row</td>
<td>Identify the row number in the source worksheet that contains the summary formulas.</td>
</tr>
<tr>
<td>Target Table, Range, or Row</td>
<td>Identify the target table, range name, or first row on the target worksheet to begin inserting the expanded detail.</td>
</tr>
<tr>
<td>Headings</td>
<td>Indicate whether or not to include column headings when expanding details. If not specified, N (No) is assumed.</td>
</tr>
<tr>
<td>Autofit</td>
<td>Indicate whether or not to autofit columns when expanding details. If not specified, N (No) is assumed.</td>
</tr>
<tr>
<td>Clearsheets</td>
<td>Indicate whether or not to clear the target worksheet before expanding details. If not specified, N (No) is assumed. <strong>Note:</strong> This value MUST be N when a TABLE or RANGE is specified for the Target Table/Range/Row parameter.</td>
</tr>
<tr>
<td>Journals Only Column</td>
<td>Identify the column for which to generate journal detail. Refer to Expand Detail Reports (GXE) - Journals Only for more information.</td>
</tr>
<tr>
<td>Account Segments:</td>
<td>Not applicable for the GXE formula.</td>
</tr>
</tbody>
</table>
5. Use the table to enter formula specific data on the GXC - Formula Assistant panel.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GXC:</td>
<td>Used to specify the values for a customized formula. Contact Global for</td>
</tr>
<tr>
<td></td>
<td>configuration of the new formula.</td>
</tr>
<tr>
<td>Query</td>
<td>Identify the custom adhoc query to be used for the customized formula. Use</td>
</tr>
<tr>
<td></td>
<td>the drop down list to select the desired query.</td>
</tr>
<tr>
<td>Parm 01-10</td>
<td>Specify the appropriate parameters for the customized formula. Field</td>
</tr>
<tr>
<td></td>
<td>values will vary based upon the requirements for the customized formula.</td>
</tr>
<tr>
<td>Account Segments:</td>
<td>Not applicable for the GXC formula.</td>
</tr>
</tbody>
</table>
6. Use the table to enter formula specific data on the GXD - Formula Assistant panel.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GXD:</td>
<td>Displays the account description for a particular account. Refer to GXD Formula for more information.</td>
</tr>
<tr>
<td>Account</td>
<td>Identify the segment value of the account string for which to retrieve the description.</td>
</tr>
<tr>
<td>Account Segments:</td>
<td>Not applicable for the GXD formula.</td>
</tr>
</tbody>
</table>

7. The Results Box near the bottom left of the panel displays the formula as it is being built. Verify the data in the Results Box is correct, and then click one of the following toolbar icons or buttons.
   - Insert (icon) or Insert (button) -- inserts the formula to the previously selected cell on the current worksheet and closes the panel.
   - Copy (icon) -- copies the formula to the Windows clipboard.
   - Cancel (button) -- closes the panel.
4.3 GXD Formula for Descriptions

Use the GXD formula to retrieve a description for a single account string.

Syntax:
\[ =\text{GXD("Segment Value")} \]

Note: It is most common to use cell references within GXD formulas to identify parameters.

Parameters:
- Segment Value
  Identifies the segment value for which to retrieve the description.

Formula Example - Using a Single Segment:
\[ =\text{GXD("402000")} \]
Retrieves the description for account segment 402000.

Formula Example - Using Multiple Segments:
\[ =\text{GXD("402000")} \& "-" \& \text{GXD("3000")} \]
Retrieves the description for account segment 402000 and concatenates the description for project segment 3000.
4.4  **GXL Formula for Account Values**

Use the GXL formula to retrieve account balances in a specific format for a reporting period.

**Syntax:**

```
=GXL("Balance Type","Business Unit","Key 3","Year","Format","Period","Ledger","Fund Code","Department","Class Field","Program Code","Chart Field 1","Account","Project","Affiliate","Statistics Code")
```

**Note:** It is most common to use cell references within GXL formulas to identify parameters.

**Parameters:**

- **Balance Type**
  Identifies the balance type. Valid types are A (Actual) and B (Budget).

- **Business Unit**
  Identifies the business unit.

- **Key 3**
  Optionally identifies currency.
  - Enter the literal "Currency=" and then specify the currency to be used.

- **Year**
  Year identifier.

- **Format**
  Format options are:
  - **PER** Activity for the selected period
  - **QTR** Activity for the periods included in the selected quarter number
  - **YTD** Activity for periods 1 through the designated period number **excluding** the opening balance
  - **LTD** Activity for periods 1 through the designated period number **including** the opening balance
  - **RANGE** Activity for a range of periods specified
  - **BP** Budget amount for the selected period

- **Period**
  Corresponds to period, quarter number, or range of periods (i.e. 1.5 for periods 1 thru 5) for the specified format.

- **Ledger**
  Ledger portion of the account string. May be a single value, mask, range, value list or segment list.

- **Fund Code**
  Fund code of the account string. May be a single value, mask, range, value list or segment list.

- **Department**
  Department portion of the account string. May be a single value, mask, range, value list or segment list.

- **Class Field**
  Class field portion of the account string. May be a single value, mask, range, value list or segment list.

- **Program Code**
  Program code portion of the account string. May be a single value, mask, range, value list or segment list.
Chart Field 1
Chart field 1 portion of the account string. May be a single value, mask, range, value list or segment list.

Account
Account portion of the account string. May be a single value, mask, range, value list or segment list.

Project
Project portion of the account string. May be a single value, mask, range, value list or segment list.

Affiliate
Affiliate portion of the account string. May be a single value, mask, range, value list or segment list.

Statistics Code
Statistics code portion of the account string. May be a single value, mask, range, value list or segment list.

Note: For parameters that allow a single value, mask, range, value list or segment list syntax examples are listed below. (For more information refer to Using Value Lists in a GXL Formula and Using Segment Lists in a GXL Formula.)

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Value</td>
<td>8000</td>
<td>Retrieves value 8000.</td>
</tr>
<tr>
<td>Mask (wildcard)</td>
<td>* -or- _</td>
<td>Retrieves all values.</td>
</tr>
<tr>
<td>Mask (wildcard)</td>
<td>85** -or- 85__</td>
<td>Retrieves values starting with 85.</td>
</tr>
<tr>
<td>Range</td>
<td>8000.8599</td>
<td>Retrieves values 8000 thru 8599.</td>
</tr>
<tr>
<td>Value List (single values)</td>
<td>[8000,8250,8370]</td>
<td>Retrieves values 8000, 8250 and 8370.</td>
</tr>
<tr>
<td>Value List (range and single value)</td>
<td>[8000.8599,8750]</td>
<td>Retrieves values 8000 thru 8599, and 8750.</td>
</tr>
<tr>
<td>Value List (range and exclude value)</td>
<td>[8000.8599,8375]</td>
<td>Retrieves values 8000 thru 8599, excluding 8375.</td>
</tr>
<tr>
<td>Segment List</td>
<td>^CASH</td>
<td>Retrieves all values in CASH segment list.</td>
</tr>
</tbody>
</table>
**Formula Example - Using Masks:**

=GXL("A","US005","CURRENCY=USD","2003","PER","6","LOCAL","*","20000","*","*","*","400000","*","*","*")

Retrieves the actual activity for period 6 of 2003 for business unit US005, ledger LOCAL, department 21400 and all accounts starting with 4.

**Formula Example - Using a Range:**

=GXL("A","US005","CURRENCY=USD","2003","PER","6","LOCAL","*","21000.21999","*","*","*","400000","*","*","*")

Retrieves the actual activity for period 6 of 2003 for business unit US005, ledger LOCAL, departments in the range of 21000 thru 21999, and account 400000.
4.5 Using Value Lists in a GXL Formula

A list of values may be entered for an account segment directly in a cell on a worksheet. The list of values may include single values, a range of values, a wild carded value, an excluded value (indicated by inserting '/' prior to the value), or a segment list. Enclose the value list in square brackets [ ] and use a comma (,) to separate values in the list.

Note: It is most common to use cell references within GXL formulas to identify parameters.

Formula Example:
=GXL("A","US005","CURRENCY=USD","2003","PER","6","LOCAL","\*[21000.21999,/21400]","\*","\*","\*","400000","\*","\*","\*")

Retrieves the actual activity for period 6 of 2003 for business unit US005, ledger LOCAL, departments in the range of 21000 thru 21999 excluding 21400, and account 400000.
4.6 Locate Segment Value or Hierarchy

The Locate Segment function is used to display a list of valid values -or- a list of hierarchy values for each account segment, and to enable the user to insert a selected value to the current active cell in Excel. Hierarchy values may be used within a standard GXL formula by replacing any of the account segment values with the desired hierarchy value. Two caret symbols (^^) must be inserted prior to the hierarchy value in the formula. Ad hoc queries must be written to retrieve hierarchy values from the ledger. Contact Global for more information.

1. Select a cell which should contain a segment value and right click. A popup menu appears.

2. From the popup menu, select SS Locate Segment. The Locate a Segment Value or Hierarchy panel appears.

   **Nav Tip:** Steps 1 and 2 may be replaced by selecting a cell and from the SServer menu, selecting Locate Segment -or- by selecting the SS ribbon equivalent (see SS Ribbon). This panel may also be accessed by selecting the Locate Segment icon on the Maintain Segment Lists panel.

3. To toggle between displaying a list of segment values and a list of hierarchy values, select the Value or Hierarchy radio button.

4. To filter for values for a specific segment, select the desired segment(s) in the Include Segments list. The system displays only values for the selected segment(s).

5. To search for a specific value in the list, key the desired segment value/name in the Search for a Segment Value/Name box. The system repositions to the first record containing the value keyed. The system repositions character by character.

6. To insert a value to the current cell in Excel and keep the panel open, select the desired value in the list and click the Insert to Current Cell icon on the toolbar -or- double click the desired value in the list. To insert a value to the current cell and close the panel, select the desired value and click the Insert button.
7. To copy the list of values currently displayed in the list, click the Copy Segment Lists to Clipboard icon on the toolbar.

8. To exit the panel, click the Cancel button.
4.7 List Accounts for a GXL Formula

This feature allows for listing account numbers which will be used in the calculation of a GXL formula.

1. Select the desired cell that contains the GXL formula in question and right-click. A popup menu appears.

2. From the popup menu, select SS List Accounts. The List Accounts window appears.

3. Review the accounts listed in the grid to ensure the formula is retrieving the appropriate accounts.

4. To modify the list of accounts being displayed on the List Accounts window, alter the value in the Filter field and click the List Accounts button.

   **Note:** Modifying the filter does not change the account segment values in the spreadsheet cell being referenced by the GXL formula.
4.8 Expand/Collapse Row for a GXL Formula

The Expand Row feature allows the user to expand the balances for GXLs on a single row or for all GXLs on the worksheet into individual account details. This process is similar to the GXE formula, but expands into additional rows on the current worksheet instead of to another designated workbook location. The detail rows may expand up or down based upon an option in the user settings.

**Note:** For the Expand option to function properly, at least one account segment must be on the row, and a description field should follow the last account segment on the row -or- a blank column should exist between the last account segment and the GXL formula.

**To Expand a Single Row:**
1. On the desired row to be expanded, select any cell containing a GXL formula and right click. A popup menu appears.

   ![Spreadsheet Example](image)

   2. From the popup menu, select SS Expand Row. The system adds additional rows to the spreadsheet listing the account details for the selected GXL(s). The expanded data appears in blue italics.

**Nav Tip:** Steps 1 and 2 may be replaced by selecting the desired cell(s) and selecting the SS ribbon equivalent (see **SS Ribbon**).

![Expanded Spreadsheet Entry](image)
To Expand All Rows:
1. Select any cell on the worksheet and from the SS ribbon click the Expand Row arrow and then select Expand All Rows. The system adds additional rows to the spreadsheet listing the account details for all GXLs on the worksheet. The expanded data appears in blue italics.

To Collapse Rows for a Single Expansion:
1. Select any cell within the expanded rows section and right-click. A popup menu appears.
2. From the popup menu, select SS Collapse Row. The system removes the expanded rows in the selected section.

**Nav Tip:** Steps 1 and 2 may be replaced by selecting any cell within the expanded rows and selecting the SS ribbon equivalent (see SS Ribbon).

To Collapse Rows for All Expansions:
1. Select any cell on the worksheet and from the SS ribbon click the Collapse Row arrow and then select Collapse All Rows. The system removes all expanded rows on the worksheet.
4.9 Spreadsheet Server Segment Lists

4.9.1 Create/Maintain Segment Lists

Spreadsheet Server Segment Lists are used to create a hierarchy of individual segments which can be used in a single GXL formula. A segment list may be used within a standard GXL formula by replacing any of the account segment values with the desired segment list name. A caret symbol (^) must be inserted prior to the segment list name in the formula for the system to recognize the segment list. A user’s ability to create/maintain segment lists is determined by a parameter setting on the user’s User tab in the Configurator component.

1. In Excel from the SS toolbar or ribbon, select Segment Lists (see SS Toolbar or SS Ribbon). The Maintain Segment Lists panel appears.

   **Nav Tip:** This panel may also be accessed by selecting the Segment Lists tab on the Control Panel -or- by selecting the Maintain Segment Lists button on the General Settings panel.

2. To create a new segment list, enter a segment list name and description, and then click the Add List button. This action creates the segment list header.

3. Enter the desired segment values in the Segment List Value field. Click the Inclusive Value or Add Exclusive Value button depending on desired criteria. If a value is excluded, a slash will appear in front of the list value. Single segment values, ranges, wildcards, or existing segment lists (nested) can be used. Segment lists can be used for any portion of the account string. When all values have been entered, click OK.

4. To remove a value from the segment list, select the value in the grid and click the Remove Value button.

5. To change an existing segment list’s description or segment list values, select the desired segment list and key over the description and/or update the segment list values. When changes are complete, click OK.

6. To copy or delete a segment list, select the list and click either the Copy List or Remove List button.
7. To paste a segment list name to the current active cell on a spreadsheet, select the segment list and click the Insert List icon on the toolbar.

8. To copy all segment list names to the clipboard, click the Copy Segment Lists icon on the toolbar.

9. To lock a segment list, select the list and click the Lock icon on the toolbar. The Password dialog box appears. Enter the desired password and click OK. Locking the segment list allows other users to access the segment list but prevents changes from being made.

10. To unlock a segment list, select the list and click the Unlock icon on the toolbar. The Password dialog box appears. Enter a valid password and click OK.

   Note: In the event all segment lists are locked and the individual required passwords are lost or forgotten, contact Global for instructions and the required password for unlocking the segment lists.

11. To purge the balances in the PC Cache file for a segment list, select the list and click the Purge List from Cache icon on the toolbar. This action can be used if a segment list is deleted or if list values are altered.

12. To import segment lists from other users' segment list .mdb files or from an ad-hoc, click the Import Segment Lists icon on the toolbar. The system prompts for the source from which to import the segment list, either an ad-hoc or a segment list .mdb. Select the appropriate source. This action opens either a list of existing ad-hocs or the Windows Explorer panel. Select the desired ad-hoc -or- browse to the location of the segment list .mdb file. Once an ad-hoc or .mdb file is selected and the values have been imported, the Maintain Segment Lists panel is automatically closed.

13. To access a list of valid values or a list of hierarchy values for each account segment, click the Locate Segment icon on the toolbar. The Locate a Segment Value or Hierarchy panel appears. Refer to Locate Segment Value or Hierarchy for more information.

14. To perform a mass clean up of the segment list .mdb file based upon filter criteria, click the Cleanup Segment List Database icon on the toolbar. This function is password protected. Contact Global for more information.

15. When the segment list(s) is complete, click OK.
4.9.2 Using Segment Lists in a GXL Formula

A segment list may be used within the standard GXL formula, by replacing any of the account segments with the desired segment list name. A caret symbol (^) must be inserted prior to the segment list name in the formula for the system to recognize the segment list.

Note: It is most common to use cell references within GXL formulas to identify parameters.

Formula Example:

=GXL("A","US005","CURRENCY=USD","2003","PER","6","LOCAL","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","","",...
4.9.3 SSLDESC Formula

Use the SSLDESC formula to retrieve the description for a segment list.

Syntax:
=SSLDESC("Segment List")

Note: It is most common to use cell references within SSLDESC formulas to identify parameters.

Formula Example:
=SSLDESC("^MiscExp")
Retrieves the segment list description for the MiscExp segment list.
4.9.4 View or Modify Segment List Values from within Excel

Spreadsheet Server allows a user to view from a worksheet, the values contained in a specific segment list. The user may also modify the values “on the fly”. Lists can be shared among all Spreadsheet Server users so caution should be exercised when making modifications.

1. From the spreadsheet, right click on the cell that contains the desired segment list. A popup menu appears.

2. On the popup menu, select SS List Accounts. The Maintain Segment Lists panel appears displaying the values for the selected segment list. Refer to Create/Maintain Segment Lists for more information about segment lists.

3. Segment list values may be added or removed as necessary.

4. When the segment list is complete, click OK.
5 Calculations

5.1 Calculation Options

Multiple options are available for retrieving and calculating data within Spreadsheet Server.

1. By default, the calculation function within Excel is set to calculate automatically. Global strongly recommends setting this value to manual so that all required spreadsheet changes or additions can be completed prior to re-calculating.

   **Nav Tip:** For Excel 2003 and Prior, this setting is found on the Calculation tab within Excel's Tools>Options menu.

   **Nav Tip:** For Excel 2007 and Above, this setting is found in the Calculation Options section on the Excel's Options Formulas panel.
   - Click the Office button. The Office Menu panel appears.
   - Click the Excel Options button. The Excel Options panel appears.
   - Select Formulas. The Excel Options Formula panel appears.

2. The following options are available for calculating spreadsheets:

<table>
<thead>
<tr>
<th>shortcut</th>
<th>description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F2+Enter</td>
<td>Calculates the active cell.</td>
</tr>
<tr>
<td>F9</td>
<td>Calculates all worksheets in all open workbooks.</td>
</tr>
<tr>
<td>Shift+F9</td>
<td>Calculates the active worksheet.</td>
</tr>
<tr>
<td>Ctrl+Alt+F9</td>
<td>Calculates all worksheets in all open workbooks, regardless of whether they have changed since the last calculation.</td>
</tr>
</tbody>
</table>

   **Nav Tip:** The majority of these options are also available by selecting the SS ribbon equivalent (see SS Ribbon).

Global Software, Inc.
5.2 Review/Refresh PC Cache

When spreadsheets are calculated, Spreadsheet Server stores the account balances in the PC's cache database. Spreadsheet Server will first look at the PC cache for account balances prior to retrieving the information from the host. As a result, it may be necessary to clear and recalculate the PC cache file when any of the following occur:

- Data has changed on the host system since the prior calculation.
- A segment list has changed since the prior calculation.
- The accounts profile has changed since the prior calculation.

1. In Excel from the SServer menu, select PC Cache. The PC Cache panel appears displaying the cached records.

   **Nav Tip:** This panel may also be accessed by selecting View PC Cache on the Cache tab on the Control Panel -or- by selecting the SS ribbon equivalent (see SS Ribbon).

2. To refresh the account balances during an Excel session, the cache records should be cleared.
   - To clear all records in the cache -- click the Clear All button.
   - To clear selected records -- select the desired records in the grid and click the Clear Selected Rows button.
   - To clear cache for a selected worksheet -- select the desired worksheet from the drop down list and click the Clear Selected Sheet button.

3. After the cache records have been cleared, the system assigns a default Recalculation Option. If necessary, use the drop down list to select a different recalculation option. Value options are:
   - Trigger Excel to automatically recalculate the entire workbook after closing the PC Cache panel.
   - Trigger Excel to automatically recalculate the entire worksheet after closing the PC Cache panel.
   - Do not trigger Excel to recalculate the after closing the PC Cache panel.

4. To automatically trigger the PC Cache refresh, in Excel from the SServer menu select Clear PC Cache and Recalculate.

   **Nav Tip:** This refresh may also be launched by using the shortcut key Shift+Ctrl+R -or- by selecting the SS toolbar or ribbon equivalent (see SS Toolbar or SS Ribbon).
# Drill Down Functionality

## 6.1 General Grid Features

Within each of the drill down grids of Spreadsheet Server, the following features exist:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Q</td>
<td>Closes all open drill down panels.</td>
</tr>
</tbody>
</table>
| Ad Hoc Drill Downs       | To drill down from a predefined grid to information retrieved by an ad hoc query, select the desired record within the grid. Right click and select Ad Hoc Drill Down. On the Ad Hoc Queries panel, select the query to be used for drill down and click Execute. In some cases, when Ad Hoc Drill Down is initially selected, the system will go directly to the drill down (not allowing the user to select a query).
|                          | Optionally, select the desired record within the grid, right click and select the desired ad hoc query from the bottom section of the popup menu. Contact Global for more information on ad hoc queries. |
| Copy                     | Select the desired records within the grid. Right click and copy the records to the Windows clipboard or directly to a worksheet. |
| Export                   | Select the desired records within the grid. Right click and export the records to the desired file format. |
| Re-sort Columns          | To re-sort a column in ascending order, click the column heading. To re-sort a column in descending order, click the column heading a second time. |
| Autosize Columns         | To automatically resize column widths in a grid to the maximum length required for the header and/or data, right click and select Autosize. |
| Dynamic Column Groupings  | To selectively summarize the amount columns by any column and to group the records by any column, drag the column heading into the summary section of the panel. Multiple levels of summarization can be created. |

![DrillDown - Detail Account Balances (Basic Layout Applied)](image-url)
Filter Row

Each column within any of the grids can be filtered by entering values into the appropriate column filter. Alphanumeric fields filter character by character. Numeric fields filter upon entry of the full field value.

Customize Grid Layout

Users may customize most drill down panel layouts by clicking the Expand button in the top left corner of the grid. A Grid Action panel appears giving the user copy and export options, available layouts to apply to the current drill down panel, and layout control options for new drill down layout design.
6.1.1 Copying/Exporting Records

1. From the drill down grid, select the desired record(s):
   - To copy/export a single record -- select the desired record and right click. A popup menu appears.
   - To copy/export select multiple records -- press and hold the Ctrl key as records are selected on the grid rows. Right click on the grid. A popup menu appears.
   - To copy/export multiple records in a range -- select the first record in the range, press and hold the Shift key, and select the last record in the range. Right click on the grid. A popup menu appears.
   - To copy/export all records in the grid -- right click on the grid. A popup menu appears. On the popup menu, select Select All. Right click on the grid again. The popup menu reappears.

2. On the popup menu, select the appropriate copy/export function.
   - Copy to Clipboard - places data on Windows clipboard.
   - Copy to Clipboard w/Headings - places data including headings on Windows clipboard.
   - Copy to Excel (Simple Table) - displays the Copy into Excel panel - see step 3.
   - Export to CSV, PDF, RTF, or Excel (Full Format) - brings up Windows Explorer panel.

3. On the Copy into Excel panel, specify the following processing criteria:
   - Include Headings - indicate whether or not to include column headings in the copy.
   - Select the appropriate radio button to indicate whether to copy to a worksheet, range or table destination. When copying to a worksheet, enter the starting cell in which to place the data and the target worksheet (new or existing). When copying to a range or table, use the drop down list to select the desired range or table.

4. Click OK to copy the data into the worksheet.
6.2 Drill Down to Detailed Account Balances

Spreadsheet Server allows drilling down from an amount on the spreadsheet to see what account balances make up the value. The Detail Account Balances drill down can exclude zero balance accounts based upon an option in the user settings.

1. Select a cell containing a GXL formula and right click. A popup menu appears.

2. From the popup menu, select SS Drill Down. The DrillDown - Detail Account Balances window appears showing the balance for each individual account. The applied grid layout name appears on the panel title bar.

**Nav Tip:** Steps 1 and 2 may be replaced by selecting a cell and from the SServer menu, selecting Drill Down -or- by selecting the SS toolbar or ribbon equivalent (see SS Toolbar or SS Ribbon).
6.3 Drill Down to Multiple Column Account Balances

Spreadsheet Server allows drilling down from multiple cells on the same row on the spreadsheet to see what account balances make up the values. A maximum of 20 columns may be selected. The Detail Multiple Account Balances drill down can exclude zero balance accounts based upon an option in the user settings.

1. Select multiple cells on the same row containing GXL formulas and right click. A popup menu appears.

2. From the popup menu, select SS Drill Down. The DrillDown - Detail Multiple Account Balances window appears showing detail account balances for each column. If only two columns were selected, a variance column will automatically be displayed.

**Nav Tip:** Steps 1 and 2 may be replaced by selecting multiple cells and from the SServer menu, selecting *Drill Down* - or - by selecting the SS toolbar or ribbon equivalent (see **SS Toolbar** or **SS Ribbon**).
6.4 Drill Down to Journals per Account(s)

Spreadsheet Server allows drilling down from detail account balances to the journals which make up the account balances.

**Note:** Drill down to journals displays YTD journals when the specified Format is LTD.

1. From the DrillDown - Detail Account Balances panel, select the desired account(s):
   - To select a single account -- double click the account. The Journals for Drill Down Balance window appears displaying journals for the selected account.
   - To select multiple accounts -- press and hold the Ctrl key as accounts are selected on the grid rows. Right click on the grid. A popup menu appears. From the popup menu select Journal List for Selected Accounts. The All Journals for Drill Down Balance window appears displaying journals for all the selected accounts.
   - To select multiple accounts in a range -- select the first account in the range, press and hold the Shift key, and select the last account in the range. Right click on the grid. A popup menu appears. From the popup menu select Journal List for Selected Accounts. The Journals for Drill Down Balance window appears displaying journals for all the selected accounts.
   - To select accounts in the grid -- right click on the grid. A popup menu appears. From the popup menu select Journal List for All Accounts. The All Journals for Drill Down Balance window appears displaying journals for all accounts.

-OR-

From the DrillDown - Detail Multiple Account Balances panel:
   - To select a single account/period -- double click the desired account period amount. The All Journals for Drill Down Balance window appears displaying journals for the selected account/period.
Review Account Master

7.1 List Accounts

Spreadsheet Server enables the user to generate a list of existing accounts. Filtering is available to control which accounts are listed on the panel.

1. In Excel from the SServer menu, select List Accounts. The List Accounts panel appears.

   **Nav Tip:** *This panel may also be accessed by selecting the List Accounts tab on the Control Panel.*

2. On the List Accounts panel, specify the desired balance key and filter for which to display accounts and click the List Accounts button. The appropriate accounts are displayed on the List Accounts panel. If the filter is left blank, the system will retrieve all account masters. When using a filter, a valid account string combination should be used. In addition, the filter can include ranges, segment lists, and/or wildcards.
7.2 Copy Accounts from Account List

Spreadsheet Server allows copying accounts from the List Accounts panel into the spreadsheet.

1. From the List Accounts panel, select the desired account(s):
   - To copy/export a single account -- select the desired account and right click. A popup menu appears.
   - To copy/export select multiple accounts -- press and hold the Ctrl key as accounts are selected on the grid rows. Right click on the grid. A popup menu appears.
   - To copy/export multiple accounts in a range -- select the first account in the range, press and hold the Shift key, and select the last account in the range. Right click on the grid. A popup menu appears.
   - To copy/export all accounts in the grid -- right click on the grid. A popup menu appears. On the popup menu, select Select All. Right click on the grid again. The popup menu reappears.

2. On the popup menu, select the appropriate copy/export function.
   - Copy to Clipboard - places data on Windows clipboard.
   - Export to Excel - displays the Copy into Excel panel - see step 3

3. On the Copy into Excel panel, specify the following processing criteria:
   - Include Headings - indicate whether or not to include column headings in the copy.
   - Select the appropriate radio button to indicate whether to copy to a worksheet, range or table destination. When copying to a worksheet, enter the starting cell in which to place the data and the target worksheet (new or existing). When copying to a range or table, use the drop down list to select the desired range or table.

4. Click OK to copy the data into the worksheet.
7.3 View Account Balances

Spreadsheet Server enables the user to view balances for a select account or accounts outside the standard Excel interface, and to subsequently drill down to the journals and journal entry lines which make up the balance.

1. From the desktop, click Start>Programs>Global Software Spreadsheet Server>Spreadsheet Server Control Panel. The Sign On dialog box appears.

2. On the Sign On dialog box, specify the appropriate data (see Started Spreadsheet Server) and click OK. The Spreadsheet Server Control Panel appears.
3. Use the following table to enter data on the Control Panel.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account String</td>
<td>Specify the account(s) for which to display balances. Manually type the account string in the field, or use the account segment fields below. When entering account selection criteria ranges, wildcards, and/or segment lists may be used.</td>
</tr>
<tr>
<td>Account Segments</td>
<td>Specify the various portions of the account string. The values entered populate the Account String field. When entering criteria ranges, wildcards, and/or segment lists may be used.</td>
</tr>
<tr>
<td>Balance Type</td>
<td>Specify the balance type. Value values are A (actuals) and B (budgets).</td>
</tr>
<tr>
<td>Business Unit</td>
<td>Specify the business unit.</td>
</tr>
<tr>
<td>Year</td>
<td>Specify the year from which to retrieve balances.</td>
</tr>
<tr>
<td>Format</td>
<td>Specify the format option for which to retrieve account balances (i.e. PER, QTR, YTD, LTD, BP).</td>
</tr>
<tr>
<td>Period</td>
<td>Specify the period for which to display the account balance in the GXL Result box.</td>
</tr>
<tr>
<td>Key 3</td>
<td>If applicable, enter &quot;Currency=NNN&quot; where NNN is the currency for which to retrieve data.</td>
</tr>
<tr>
<td>Period 00 - 15</td>
<td>Displays the calculated balance by period for the account or accounts selected in the filter.</td>
</tr>
</tbody>
</table>

4. To display balances for the selected account(s), click the GXL button. The balances are displayed in the Period 00 to 15 fields, and the total for the period is displayed in the GXL Result box.

   **Note:** The Control Panel uses the same caching process as the Excel portion of Spreadsheet Server. After an account string is queried, the string and balance are stored in cached memory. Any subsequent calculations will use the records in memory. To ensure the latest balances, use the clear cache process prior to rerunning the GXL. Refer to [Control Panel - Cache Options](#) for more information.

   **Note:** Upon calculation, at the bottom of the Control Panel, the system will blink which mode is being used to retrieve the balances (i.e. Cache = cached memory, Host = live connection, or Local = local connection).

5. To view the account balances journals, click the corresponding Drill button. The system displays the Drilldown- Detailed Account Balances panel.

   **Note:** Refer to [Drill Down to Detailed Account Balances](#) for more information on drill down capabilities.
8 Miscellaneous Features

8.1 SS Validation

Spreadsheet Server gives the user the ability to create a validation list in a specific cell in Excel. Validation lists are drop down lists that allow the user to choose from a valid list of options/field values.

1. Select a cell to hold the validation list and right click. A popup menu appears.

2. From the popup menu, select SS Validation. The Data Validation panel displays.

   **Nav Tip:** Steps 1 and 2 may be replaced by selecting a cell and selecting the SS toolbar or ribbon equivalent (see SS Toolbar or SS Ribbon).

3. Select the type of data for which to build a list or enter valid values separated by a comma in the Custom field, and click OK to push validation to the current cell.

   **Note:** Validation Lists are limited by Excel to 255 characters.

4. On the Excel worksheet when the appropriate cell is selected, a drop down button appears indicating that valid values exist for the cell. Click on the drop down arrow button to display the Validation List.

5. Click on the desired value. The system returns the selected value to the appropriate cell.

6. To maintain valid values for a cell, select the cell and from the Excel menu, select Data>Validation -or- from the Ribbon select Data>Data Tools>Data Validation. The Data Validation panel appears. Refer to Excel Help for additional instructions.
8.2 Account Security

An Accounts Profile allows an administrator to control the account strings that a particular user may access. An Accounts Profile may be set up via the Maintain Accounts Profile button (see instructions below) or via the Application Configurator. If Override User Account Profile values are assigned to the user in the Application Configurator, then the Maintain Accounts Profile function is only used to display, not maintain, Accounts Profiles.

1. In Excel from the SServer menu, select Settings. The General Settings panel appears.

   **Nav Tip:** This panel may also be accessed by selecting the Settings tab on the Control Panel - or - by selecting the SS toolbar or ribbon equivalent (see SS Toolbar or SS Ribbon).

2. Click the Maintain Accounts Profile button. The Accounts Profile panel appears.

   **Nav Tip:** This panel may also be accessed by selecting the Accounts Profile tab on the Control Panel.

3. Use the Segment Labels drop down list to select the ledger or Designer GL definition for which to display account segments.

4. In the Account Mask fields on the Accounts Profile panel, specify the account string to which the user will have access and click the Add button. Single account strings, ranges, wildcards, segment lists and value lists may be entered. A maximum of 20 different account strings is allowed per profile.

   **Note:** When using a segment list, the segment list may not include “excluded” values.

5. Repeat steps 3 and 4 until all account masks for the account profile have been added.

6. To remove an account mask from the list, select the value in the grid and click the Remove button. To remove all account masks from the list, click the Clear All button.

7. To lock the account profile for security purposes (i.e. prevent others from making changes to the account profile), click the Lock icon button. The Password dialog box appears. Enter the desired password and click OK. This password is required to change the account profile. It is not mandatory to lock an account profile.
8. To unlock the account profile, click the Unlock icon button. The Password dialog box appears. Enter the valid password and click OK.

9. When the account profile is complete, click the Close button.
8.3 Generate Account Detail for Current Sheet

The Generate Account Detail option allows the user to create an audit trail which lists the individual accounts and balances included in the GXL formulas of the worksheet.

1. In Excel from the SServer menu, select Generate Account Detail for Current Sheet. The Generate Account Detail Options panel appears.

   **Nav Tip:** This panel may also be accessed by selecting the SS ribbon equivalent (see SS Ribbon).

   ![Generate Account Detail Options Panel]

2. On the Generate Account Detail Options panel, specify the following processing criteria:
   - Source Worksheet Input - Column - Identify the column within the worksheet that contains the report line description. This description is used as the first column in the extracted audit trail.
   - Source Worksheet Input - Row - Identify the first row containing a GXL formula to be used in generating the detail. This will set the starting point for the extracted audit trail.
   - Target Options - Indicate whether to copy the selected records to the standard Windows clipboard or to paste data directly to a target worksheet in the spreadsheet. When pasting directly to a worksheet, a starting cell into which to place the data and a target worksheet (new or existing) must be specified.

3. Click OK. An audit trail showing the line description, all included accounts, and their balances will be generated.

<p>| | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Template Account Line</td>
<td>LOCAL</td>
<td>21000</td>
<td>400000</td>
<td>Product Revenue</td>
</tr>
<tr>
<td>2</td>
<td>Template Account Line</td>
<td>LOCAL</td>
<td>21100</td>
<td>400000</td>
<td>Product Revenue</td>
</tr>
<tr>
<td>3</td>
<td>Template Account Line</td>
<td>LOCAL</td>
<td>21300</td>
<td>400000</td>
<td>Product Revenue</td>
</tr>
<tr>
<td>4</td>
<td>Template Account Line</td>
<td>LOCAL</td>
<td>21400</td>
<td>400000</td>
<td>Product Revenue</td>
</tr>
</tbody>
</table>
8.4 Expand Detail Reports (GXE) - Account Detail

The Expand Detail option allows the user to select a single or multiple financial statement lines using Spreadsheet Server formulas and expand the line(s) into the individual account details. This process is similar to the Generate Account Detail option but uses a single line to expand into a designated workbook location.

This process is primarily used to launch detailed financial statements into the same template. This option can be used for multiple departments to ensure consistency for each report. Instead of creating each possible account number as different rows in the spreadsheet, a single line can be created that contains ranges, segment lists, or wildcards. This line will then be expanded into the applicable individual accounts and placed into a formatted worksheet.
8.4.1  Expand a Single Source Line

1. Create a standard Spreadsheet Server report for the GXL formula using Build a Template (see Build a Template). The single report line becomes the basis for the expanded report. When the process is executed the single line will be expanded into individual account lines and placed into the final formatted worksheet (see below).

The example below shows a report based on an account mask.
- GXL formulas are created in a single line. In the example, the account string parameters are shown in cells B9:B18. The balance parameters of the GXL (balance type, business unit, year, format, period, currency) are entered in each column heading (B1:C7). The actual GXL formulas are contained in cells B21 and C21.
- Standard Excel formula is used to calculate the variance in cell D21.
- Various literals are entered in cells E21:P21. This designation will generate the associated value into that particular column. Valid literals are ACCTNUM (account number), ACCTDESC (account description), and ACCTSEGnn (where nn equals the account segment number, such as 01, 02, 03, etc).

Note: The maximum number of columns to be expanded is based upon an option in the user settings.

2. Using Build a Template (see Build a Template) for the GXE formula, define the parameters and starting column and row for the formula.
3. After the GXE data has been entered and verified, click the Insert icon or button. The parameters and GXE formula are inserted to the selected worksheet (see the sample spreadsheet above).

**Formula Example:**

=GXE(B24,B23,B26,B25,B27,B28,B29,B30)

4. Format the Target Worksheet with headings in rows 1-3, blank rows in rows 4-6, and totals in row 7. Set each total to a range of rows 4-6 (i.e. =SUM(B4:B6)). When the Expand Detail Reports function is initiated, the total line is shifted down or up, based upon the number of data rows populated each time the expansion is processed.

5. To generate detail reports for all GXE formulas in the workbook, in Excel from the SServer menu select Generate All Detail Reports (GXE) -or- select the SS ribbon equivalent (see SS Ribbon). The results for all GXE formulas are expanded into the appropriate formatted sheets.

To generate a detail report for a single GXE formula, select the cell containing the GXE formula, right click and select SS Generate This Detail Report (GXE) -or- select the SS ribbon equivalent (see SS Ribbon). The results for the selected GXE formula are expanded into the appropriate formatted sheet.
<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Current Pd</td>
<td>Last Pd</td>
<td>Variance</td>
<td>Account</td>
<td>Description</td>
<td>Ledger</td>
<td>Department</td>
<td>Account</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>(426,072)</td>
<td>(65,600)</td>
<td>(360,472)</td>
<td>LOCAL--21400-----400000----</td>
<td>Product Revenue</td>
<td>LOCAL</td>
<td>21400</td>
<td>400000</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>(112,000)</td>
<td>(68,486)</td>
<td>(43,514)</td>
<td>LOCAL--21400-----401000----</td>
<td>Service Revenue</td>
<td>LOCAL</td>
<td>21400</td>
<td>401000</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>(82,105)</td>
<td>(73,000)</td>
<td>(9,105)</td>
<td>LOCAL--21400-----402000----</td>
<td>Freight Revenue</td>
<td>LOCAL</td>
<td>21400</td>
<td>402000</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>900</td>
<td>1,120</td>
<td>(220)</td>
<td>LOCAL--21400-----403000----</td>
<td>Returns and Allowances</td>
<td>LOCAL</td>
<td>21400</td>
<td>403000</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>(619,277)</td>
<td>(205,965)</td>
<td>(413,312)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
8.4.2 Expand Multiple Source Lines

1. Create a standard Spreadsheet Server report for the GXL formula using Build a Template (see Build a Template). The multiple report lines become the basis for the expanded report. When the process is executed the lines will be expanded into individual account lines and placed into the final formatted worksheet (see below).

The example below shows a report based on individual account masks.
- GXL formulas are created on multiple lines. In the example, the account string parameters are shown in cells B10:B19, C16 and D16. The balance parameters of the GXL (balance type, business unit, year, format, period, currency) are entered in each column heading (B1:H7). The actual GXL formulas are contained in cells B22:B24, C22:C24, G22:G24, and H22:H24.
- Standard Excel formulas are used to calculate the variances in cells D22:D24 and I22:I24.
- Various literals are entered in cells E22:F24. This designation will generate the associated value into that particular column. Valid literals are ACCTNUM (account number), ACCTDESC (account description), and ACCTSEGnn (where nn equals the account segment number, such as 01, 02, 03, etc). See Expand a Single Source Line for an ACCTSEGnn example.

Note: The maximum number of columns to be expanded is based upon an option in the user settings.

2. Using Build a Template (see Build a Template) for the GXE formula, define the parameters and starting column and row for the formula.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Worksheet</td>
<td>Identify the name of the worksheet that contains the summary formulas that will be expanded.</td>
<td>GXE Source Multiple</td>
</tr>
<tr>
<td>Target Worksheet</td>
<td>Identify the name of the worksheet that contains the final formatted worksheet and will receive the expanded detail.</td>
<td>GXE Target Multiple</td>
</tr>
<tr>
<td>Source Detail Row</td>
<td>Identify the row number in the source worksheet that contains the summary formulas.</td>
<td>22 23 24</td>
</tr>
<tr>
<td>Target Table, Range, or Row</td>
<td>Identify the target table or range name on the target worksheet to begin inserting the expanded detail.</td>
<td>Range1 Range2 Range3</td>
</tr>
<tr>
<td>Headings</td>
<td>Enter Y or N to indicate whether or not to include column headings when expanding details. If not specified, N (No) is assumed.</td>
<td>N</td>
</tr>
<tr>
<td>Autofit</td>
<td>Enter Y or N to indicate whether or not to autofit columns when expanding details. If not specified, N (No) is assumed.</td>
<td>N</td>
</tr>
<tr>
<td>Clear Sheet</td>
<td>Enter Y or N to indicate whether or not to clear the target worksheet before expanding details. If not specified, N (No) is assumed.</td>
<td>N</td>
</tr>
<tr>
<td>Journals Only Column</td>
<td>Not applicable when using the GXE to expand account detail.</td>
<td>(leave blank)</td>
</tr>
<tr>
<td>Starting Column</td>
<td>Identify the starting column for the template.</td>
<td>A</td>
</tr>
<tr>
<td>Starting Row</td>
<td>Identify the starting row for the template.</td>
<td>26</td>
</tr>
</tbody>
</table>

3. After the GXE data has been entered and verified, click the Insert icon or button. The parameters and GXE formula are inserted to the selected worksheet (see the sample spreadsheet above).

**Formula Example:**

=GXE(B27,B26,B29,B28,B30,B31,B32,B33)
=GXE(B27,B26,C29,C28,B30,B31,B32,B33)
=GXE(B27,B26,D29,D28,B30,B31,B32,B33)

4. Format the Target Worksheet with headings in rows 1-3, 9 and 15, blank rows in rows 4-6, 10-12 and 16-18 and totals in row 7, 13 and 19. Set each total to a range of rows 4-6, 10-12 or 16-18 (i.e. cell A7 is =SUM(A4:A6)). When the Expand Detail Reports function is initiated, the total lines are shifted down or up, based upon the number of data rows populated each time the expansion is processed.
5. To generate detail reports for all GXE formulas in the workbook, in Excel from the SServer menu select Generate All Detail Reports (GXE) - or - select the SS ribbon equivalent (see SS Ribbon). The results for all GXE formulas are expanded into the appropriate formatted sheets.

To generate a detail report for a single GXE formula, select the cell containing the GXE formula, right click and select SS Generate This Detail Report (GXE) - or - select the SS ribbon equivalent (see SS Ribbon). The results for the selected GXE formula are expanded into the appropriate formatted sheet.
8.5  Expand Detail Reports (GXE) - Journals Only

The Expand Detail option allows the user to create a detail journal voucher listing for a specific summary balance of accounts using the GXE formula. The process works similarly to the Expand Detail option for account detail, but uses additional parameters.

1. Create a standard Spreadsheet Server report for the GXL formula using Build a Template (see Build a Template). The single balance becomes the basis for the journal entry detail. When the process is executed the single column balance will be expanded into detail journal lines and placed into the target worksheet (see below).

The example below shows a GXL formula totaling on an account mask. In the example, the account string parameters are shown in cells B10:B19. The balance parameters of the GXL (balance type, business unit, year, format, period, currency) are entered in the cells B1:B7. The actual GXL formula is contained in cell B22.

![Excel formula screenshot](image.png)

2. Using Build a Template (see Build a Template) for the GXE formula, define the parameters and starting column and row for the formula.
3. After the GXE data has been entered and verified, click the Insert icon or button. The parameters and GXE formula are inserted to the selected worksheet (see the sample spreadsheet above).

**Formula Example:**

=GXE(B25,B24,B27,B26,B28,B29,B30,B31)

4. To generate detail reports for all GXE formulas in the workbook, in Excel from the SServer menu select Generate All Detail Reports (GXE) -or- select the SS ribbon equivalent (see SS Ribbon). The results for all GXE formulas are expanded into the appropriate formatted sheets.

To generate a detail report for a single GXE formula, select the cell containing the GXE formula, right click and select SS Generate This Detail Report (GXE) -or- select the SS ribbon equivalent (see SS Ribbon). The results for the selected GXE formula are expanded into the appropriate formatted sheet.
8.6 Hide Rows with Zero Balances

The Hide Rows with Zero Balances function will analyze the active workbook and perform a row hide function for any spreadsheet row that contains GXL formulas in which the net result is zero for all cells. This function is very effective for standardized reporting templates such as departmental reports. Multiple rows can be created as a template but the function can then hide non-used or zero rows.

To Hide Rows with Zero Balances:
1. In Excel from the SServer menu, select Hide Rows with Zero Balances -or- select the SS toolbar or ribbon equivalent (see SS Toolbar or SS Ribbon).

To Restore Hidden Rows:
1. In Excel from the SServer menu, select Restore Hidden Rows -or- select the SS toolbar or ribbon equivalent (see SS Toolbar or SS Ribbon).
8.7 Disable / Enable Spreadsheet Server Formula Calculations

Disabling calculations will effectively halt GXD and GXL formula calculations when Excel calculates
spreadsheets. As a result of disabling calculations, GXD formulas will return <SS Not Connected> values and
GXL formulas will return zero values. When disabled, Spreadsheet Server does not communicate to the Host.

Disabling Spreadsheet Server formula calculations can be extremely useful when:
- Discontinuing calculation of a complex or long-running spreadsheet. Press Shift+Ctrl+Z to quickly disable
formula calculations.
- A workbook is inadvertently opened whose calculation option is set to automatic. Press Shift+Ctrl+Z to quickly
disable formula calculations.
- Creating a new worksheet or modifying an existing worksheet by adding columns and/or rows with
Spreadsheet Server formulas, and switching a format to/from the range type period. In Excel from the
SServer menu, select Disable Spreadsheet Server -or- select the SS toolbar or ribbon equivalent (see
SS Toolbar or SS Ribbon).

Enabling Formula Calculations:
1. In Excel from the SServer Disabled menu, select Start Spreadsheet Server -or- select the SS ribbon equivalent
(see SS Ribbon). The Sign On to Spreadsheet Server dialog box appears.

2. On the Sign On dialog box, specify the appropriate data (see Starting Spreadsheet Server) and click OK.

Note: When unattended (auto) signon is activated, step 2 is not applicable.
8.8 Reset Host Server Connection

Spreadsheet Server allows the user to switch from one host server to another without having to close and restart Excel.

1. In Excel from the SServer menu, select Disable Spreadsheet Server -or- select the SS toolbar or ribbon equivalent (see SS Toolbar or SS Ribbon).

2. In Excel from the SServer Disabled menu, select Start Spreadsheet Server -or- select the SS ribbon equivalent (see SS Ribbon). The Sign On to Spreadsheet Server dialog box appears.

3. On the Sign On dialog box, specify the appropriate data (see Starting Spreadsheet Server) and click OK.

Note: When unattended (auto) signon is activated, step 3 is not applicable.
8.9 View Log Entries

During all processing, the system records various logging information. If the Settings option Enhanced Logging is selected, then the system records additional error message logging data. Log entries may be viewed, copied and/or emailed if desired.

1. In Excel from the SServer menu, select Settings. The General Settings panel appears.
   
   **Nav Tip:** This panel may also be accessed by selecting the Settings tab on the Control Panel -or- by selecting the SS toolbar or ribbon equivalent (see SS Toolbar or SS Ribbon).

2. On the General Settings panel, click the View Log button. The Log Viewer panel appears displaying the level, date, time and description for each log entry. In addition, in the bottom right hand corner the panel displays a count of the number of entries listed.
   
   **Nav Tip:** When the Enhanced Logging option is selected on the Settings panel, then this panel may also be accessed by selecting the SS ribbon equivalent (see SS Ribbon).

Note: To select a different size font, click on the drop down arrow in the bottom right hand corner.

3. To copy selected records to the clipboard, on the Log Viewer panel first select the desired record(s) and then either click the Copy Selected Errors button -or- right click on the list and select Copy Selected Errors on the popup panel:
   - To copy a single record -- select the desired record.
   - To copy select multiple records -- press and hold the Ctrl key as records are selected in the list.
   - To copy multiple records in a range -- select the first record in the range, press and hold the Shift key, and select the last record in the range.
4. To email the entire log file to the helpdesk, click the Email Error Log button. The system opens a new Outlook® email panel with the log file attached. Modify the email address and/or text of the email body as necessary and click the Send button.

5. To filter the entries in the log file, select the desired message type(s), date/time range, containing text, class and/or method in the Filter section. The system displays only entries matching the selection criteria. Click the Clear Filter button to reset all filter fields to their default value.

6. To search for a specific value in the log file, key the desired value in the Find What field and click the Find Next button. The system will highlight the first log entry containing the value. Click the Find Next button again, to find the next occurrence of the selected value.

7. To clear the log file, click the Clear Log button.

8. To display the full details of a log entry, double click the selected entry in the list. The Error Properties panel appears. Use the arrow buttons on the Error Properties panel to scroll up or down through the log entries in the list. To copy detail data for a single log entry to the clipboard, click the Copy button. Click the Close button to return to the Log Viewer panel.

9. To exit the Log Viewer panel, click the Close button.
Index

- A -
  account 66
  balance 66
  balance drill down 61
  description 41
  generate audit trail 71
  journal drill down 63, 66
  journal entry line drill down 66
  master balances 66
  multiple columns drill down 62
  security 69
  account master 64
  copy accounts 65
  drill down 66
  list 64
  accounts profile 69
  ad hoc drill down 58
  add-in 7
  audit trail 71
  autosize grid columns 58

- B -
  benefits and features 4
  build a template 29
  GXE 29
  GXL 29
  GXL using clear/do not clear worksheet 33
  GXL using insert column data only 34
  GXL using shift worksheet data 35
  building spreadsheets 28

- C -
  cache options 19
  calculation options 56
  disable 82
  enable 82
  refresh PC cache 57
  collapse row 49
  components 5
  configurator 5
  control panel 19
  cache options 19
  help options 20
  overview 17
  view account balances 66
  copy accounts 65
  copy grid records 58, 60
  customize grid layout 58

- D -
  data validation 68
  disable formula calculations 82
  drill down 66
  account balances 66
  ad hoc 58
  detailed account balances 61
  general grid features 58
  journals 63
  multiple column account balances 62

- E -
  enable formula calculations 82
  error log 84
  Excel add-in 7
  expand detail reports 72
  account detail 72
  account detail (multiple source lines) 76
  account detail (single source line) 73
  journal detail 79
  expand row 49
  export grid records 58, 60

- F -
  features and benefits 4
  filter grid records 58
  formula 82
  disable calculations 82
  enable calculations 82
  GXC 36
  GXD 36, 41
  GXE 36, 72, 73, 76, 79
  GXL 36
  GXL for account values 42
  GXL using segment lists 53

© 2011 ... Global Software, Inc.
- G -
generate account detail 71
grid features 58
  ad hoc drill down 58
  autosize columns 58
  copy records 58, 60
  customize layout 58
  export records 58, 60
  filter records 58
  group/total records 58
  re-sort columns 58
group grid records 58
GXC  36
GXD  36, 41
GXE  29, 36, 72
  journal detail 79
  multiple source lines 76
  single source line 73
GXL  29, 36
  build a template using clear/do not clear worksheet 33
  build a template using insert column data only 34
  build a template using shift worksheet data 35
  expand/collapse row 49
  for account values 42
  list accounts 48
  using segment lists 53
  using value lists 45

- H -
help options 20
hide zero balance rows 81
hierarchy/segment locate 46
host server 83
  reset connection 83

- I -
installation 7

- J -
journal drill down 63

- L -
list accounts 48
  account master 64
  copy accounts 65
  in GXL formula 48
  segment list 55
locate segment/hierarchy 46
Log Viewer 84

- M -
menu 10

- N -
navigation 9
  SS ribbon 13
  SS toolbar 12
  SServer menu 10

- O -
optional components 5

- P -
PC cache 19, 57
product upgrades 20

- R -
refresh PC cache 57
register sample DSN 20
required components 5
reset host server connection 83
re-sort grid columns 58
restore hidden rows 81
ribbon 13
- S -
security account profile 69
segment lists 51
  create/maintain 51
description 54
  using in GXL 53
view values 55
segment/hierarchy locate 46
settings 21
SS ribbon 13
SS toolbar 12
SS validation 68
SServer menu 10
SSLDESC 54
start Spreadsheet Server 15
  enable formula calculations 82
reset host server connection 83

- T -
template wizard (see build a template) 29
toolbar 12

- U -
uninstall 8
upgrades 20
user manual 20
user settings 21

- V -
validation lists 68
value lists 45
  used in GXL 45
view account balances 66
view log 84

- W -
wizard template (see build a template) 29

- Z -
zero balance rows 81
  hide 81
  restore 81